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1. Introduction

This document describes the installation and usage of Dialog GreenPAK® Designer software. This software can
be used as a stand-alone application for the firmware development and for GreenPAK chips programming. If the
information in this guide is not sufficient to resolve issues experienced with GreenPAK Designer, refer to the
resources listed under the Support section.

Features that are common for GreenPAK 3 Designer, GreenPAK 4 Designer, GreenPAK 5 Designer and
GreenPAK 6 Designer are described in chapters with a GreenPAK Designer general name. The differences are
described in separate chapters.

1.1 Application Overview

Each GreenPAK Designer (GreenPAK 3 Designer, GreenPAK 4 Designer, GreenPAK 5 Designer, GreenPAK 6
Designer) is a full-featured integrated development environment (IDE) that allows you to specify exactly how you
want the device to be configured. This provides you direct access to all GreenPAK device features and complete
control over the routing and configuration options. GreenPAK Designer will be used as a general name for
GreenPAK 3-6 Designer.

GreenPAK Designer has an integrated programming tool that allows you to program configured design into your
GreenPAK chip. With this tool you can also read an already programmed chip and export its data to the Designer.
Designer will generate a project, which has the same configuration as chip.

To start working with GreenPAK Designer please take the following steps:
— Download and install GreenPAK Designer software;
— Select what components you need;
— Interconnect and configure components;
— Specify the pinout;
— Test your design with the Emulation Tool;
— Use appropriate GreenPAK development platform to program your project into GreenPAK chip. You can
find your kit on Dialog's webstore.

1.2 System requirements

PC System Configuration

Minimum System Requirements for Dialog GreenPAK Designer:

CPU: 1800MHz

System Memory (RAM): 512MB

Graphics Card: 128MB

Free Hard Disk Space: 200MB

Operating System: Windows 7/8.1/10, MAC OS X (v10.8 or higher), Ubuntu 16.04/18.04 (32, 64-bit), Debian 10
(32, 64-bit).

Dialog Semiconductor www.dialog-semiconductor.com
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1.3 Support

Free support for GreenPAK is available online at http://www.dialog-semiconductor.com
Also click Help- > Social in GreenPAK Designer and get access to Facebook, Twitter, LinkedIn and Dialog TV.

For software updates, please go to the Software page on our website.
You can find all these resources in the Help menu of GreenPAK Designer.

1.4 Acronyms
These are the acronyms used in the User Guide.

Table 1-1. Acronyms

Acronym Description
GPD GreenPAK Designer
GPP GreenPAK Programmer
IDE Integrated Development Environment
I/1O Input/Output
IC Integrated Circuit
OE Output Enable
uUSB Universal Serial Bus
GPIO General Purpose Input / Output
GPI General Purpose Input
GPO General Purpose Output
NMOS N-channel MOSFET
(metal-oxide-semiconductor field-effect transistor)
PMOS P-channel MOSFET
(metal-oxide-semiconductor field-effect transistor)
ASM Asynchronous State Machine
Dialog Semiconductor www.dialog-semiconductor.com
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2. GreenPAK Designer Launcher
This section describes GreenPAK Designer launcher application and its features.

Figure 2-1. GreenPAK Designer Launcher User Interface

i ﬁ SLG46880V
Fiftel
Part Numb D5 Size(mm) | GPIO  ACMP | M Max. Max. VDD (V) = VDDZ(V) State Mach 12¢ Pov
art Number ize (mm) LT CNT/DLY DEF/LATCH ate Machine ov
8 SLG4626TM PDF 1.6x3.0 10 4 23 8 21 25t03.0 - - Yes Dual 43
W SLG46355V PDE 1.6x2.0 12 4 23 8 21 25t0 5.0 - Yes
Develop W SLGAGB26Y PDF 2.0x3.0 17 4 19 8 17 25t0 5.0 1.8to VDD - Yes
EI SLGA6BR1V PDF 40x4.0 28 4 12 5 5 25t030 25toVDD 12-state Asynchroncus  Yes
PDE
W SLGA6583Y PDF 2.0x3.0 9 4 15 5 9 25t0 5.0 - B-state Asynchronous  Yes
W SLGA6582Y PDF 20x3.0 9 4 15 5 9 251050 - 8-state Asynchronous  Yes
Demo W0 SLG46520V PDF 20x3.0 9 4 15 5 9 25t03.0 - 8-state Asynchronous  Yes
- SLG46538M PDFE 20x22 17 4 17 7 8 1.8t0 5.0 1.8to VDD  8-state Asynchronous  Yes
8 SLG46538Y PDF 20x3.0 17 4 17 7 8 1.8t0 5.0 1.8to VDD  B-state Asynchronous  Yes
. SLG46537TM PDF 20x22 18 4 17 7 e 18t0 3.0 - 8-state Asynchronous  Yes
WSS C1ocEaT nne- an.an an a Lk = 1 -En L PO S S LY. =4
L] r
‘What's New Details
[ Datasheet | Product page | Application notes | Get samples | Contact us ] =
Package:
STQFN-32L
R
OVERE Description:
The 5LG46880/81 provides a small, low power macrocell for commonly used mixed-signal functions. The user creates their circuit design by programming the one time Non-Volatile
Mermory (NVM) to configure the interconnect logic, the IfO Pins and the macrocells of the SLG46880/81. This highly versatile device allows a wide variety of mixed-signal functions to
be designed within a very small, low power single integrated circuit. The macrocells in the device incude the following:
* Two High Speed General Purpose ACMPs;
* Two Low Power General Purpose ACMPs;
* Two Voltage References (Vref):
* Two Vref Qutputs;
* Twelve Combination Function Macrocells:
* One Selectable DFF/Latch or 2-bit LUT;
* One Selectable Programmable Pattern Generator or 2-bit LUT;
* Four Selectable DFF/Latch or 3-bit LUTS;
Datasheets * One Selectable Pipe Delay or Ripple Counter or 3-bit LUT; -
User Guides New 9 0pen Clase

GreenPAK Designer launcher:

Welcome — welcome page with short information and tips for new users.

Develop — on this page user can select chip revision to start new project for required revision:
SLG46721V, SLG46722V, SLG46108V, SLG46110V, SLG46116V, SLG46117V, SLG46120V/P,
SLG46121V, SLG46125M, SLG46127M, SLG46169V, SLG46170V, SLG46621V, SLG46620V/G/-AG,
SLG46140V, SLG46531V, SLG46532V, SLG46533V/IM, SLG46534V, SLG46535V, SLG46536V,
SLG46537V/IM, SLG46538V/M, SLG46517M, SLG46580V, SLG46582V, SLG46583V, SLG46585M,
SLG46880V, SLG46881V, SLG46826V/G, SLG46827-AG, SLG46824V/G, SLG46855-AP, SLG46855YV,
SLG46867M.

Demo - on this page user can start GreenPAK Designer in Demo mode for selected Demo project and
read information about it.

What's New — page with information about current projects and chips application.

Recovery Files — page with restored files after crash or freeze. Files was saved with Autosave feature in
predetermined time intervals.

New Project — starts new project for selected chip revision (or double-click with left mouse button on selected chip

revision

icon);

Open Project — opens existing project, automatically selects chip revision;

Close —

close GreenPAK Designer Launcher.

Dialog Semiconductor www.dialog-semiconductor.com
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3. GreenPAK Designer
This section describes GreenPAK Designer application and its features.

3.1 GreenPAK Designer Interface Overview

GreenPAK Designer consists of: main menu, toolbar, main work area, output window, properties panel and
components list (see Figure 3-1, Figure 3-2).

Figure 3-1. GreenPAK User Interface
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Figure 3-2. GreenPAK 4 User Interface
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3.1.1. Main Menu
Main menu contains controls described below:

- File

New - start new or open existing project from GPAK Launcher;
Open — open existing project in GP Designer;

Clear — clear project and select revision for specified chip;
Open in current — open existing project for specified chip;

Save — save current project;

Save as — save current project in specified location;

Import NVM bits — load configuration bits from text file;

Export NVM bits — save configuration bits to text file;

Print — start Print Editor referring item 4;

Print Sch (Beta) — simple print feature without detailed block information;
Project Information;

Application Notes — opens examples web page;

Exit program — close GPD;

Rotate Left — rotate a selected block counterclockwise;
Rotate Right — rotate a selected block clockwise;

Flip Horizontal — horizontal reflection of a selected block
Flip Vertical — vertical reflection of a selected block

Align Horizontal — horizontal alignment of selected blocks
Align Vertical — vertical alignment of selected blocks

Set Label — creating a text label for selected blocks
Erase Label — erasing text labels near selected blocks
Set Wire — enable wire creating mode;

Erase Wire — enable wire erase mode;

Zoom in — increase the work area scale;

Zoom out — decrease the work area scale;

Fit work area — tune scale to show all blocks visible in project;
Zoom 1:1 — set default scale;

Full-screen mode — switch to full-screen mode

Pan mode — enable/disable scene move in pan mode;
Show hints — enable/disable hints for blocks on the scene;
Properties — show/hide Properties panel;

Components — show/hide Green PAK blocks list;

NVM Viewer — show/hide NVM bits viewer;

Rules Checker Output;

Dialog Semiconductor
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* Debug - this tool is included for convenient project testing;
* Rules Checker — checks current design for correct settings;
* Comparison — compares bits of two projects;

* ASM Editor — allows to configure the State Machine using state diagram and set the output
configuration for SM Output block;

¢ |2C Tools — enhanced 12C tools with 12C snapshot Reconfigurator (only in GreenPAK 5-6

Designer);
- Options
e Settings — default projects folder, autosave, toolbars position, recovery, shortcuts and update
options;

- Help
* Help — show help window;
* User Guides — open User guides web page;
* Legend box — show the color legend box;
* Dialog web site — open Dialog official web site;
* Software and documentation — open Software & Dock web page;
* Dialog web store — open Dialog chip store;
* Design support — web page with training courses and videos;
¢ Contact Us — web form with request;
¢ Social — Dialog Semiconductor in social networks;
* Application Notes — open examples web page;
¢ Datasheet — open documentation web page;
¢ Updater — open GreenPAK update tool;
* About GreenPAK Designer — show information about GPD versions modification.

3.1.2. Tool-bars
Toolbar provides a quick access to frequently used functions. There are 8 tool-bars:

- File
* New;
* Open;
* Save;
*  Print;
- Undo
* Undo;
* Redo;
- Wire
e Set wire;
* Erase Wire;
- Label
e Set Label;

* Erase Label;

Dialog Semiconductor www.dialog-semiconductor.com
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- Item editor

Rotate Left;
Rotate Right;
Flip Horizontal;
Flip Vertical;
Align Horizontal;
Align Vertical,

Rules Checker;

Debug;

ASM Editor (only in GreenPAK 5-6 Designer);
Project Settings;

Project Info;

- Panel switcher

Properties;
Components;
NVM Viewer;

- Navigation

Zoom slider — adjust scale;
Zoom 1:1;

Fit work area;

Full screen mode;

Pan mode;

Show item hint;

Dialog Semiconductor

12/19/2019
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3.1.3. Work Area

Work area contains all blocks available in GreenPAK chip and their connections. In GreenPAK 4 Designer
(SLG46620V and SLG46621V) work area consist of 2 matrices: Matrix0 and Matrix1(Figure 3-4). The components
of each matrix can be interconnected through 10 input and 10 output ports.

Matrices window placement define buttons: [0+ )v 1] 3]

- Matrix O (full screen);

- Matrix 1 (full screen);

- Vertical placement (2 matrices);

- Horizontal placement (2 matrices);

- One of matrices in separate window or monitor.

Figure 3-4. Two matrices of GreenPAK 4 Designer.

[SLGA6620V] - GreenPAK4 Designer v4.01 - a

Fle Edft View Tools Options el
U -y [ Q. § & b4 % Ay L2 @
H = 5 M L vz w - F) 7| N ] p a
New Open Save Print. SetWire  Erase Wire Setlabel  EraseLabel Rules Checker Emulator Project Settings. Project Info Properties | Components | NVM Viewer Datasheet  Examples  User Guides

[*Rotateleft  “L Rotate Right Fip Horizontal Fipvertcal (1] Algn Horizontal | Align Vertical
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3
<
I

P17

3

o
o
o It
o
s

=X =X
L
=X =X
=X
=x =X
=X =X

13
<

Three types of components connection:
- Connectivity matrix connections (green) — user can connect any output to any input through wiring tool;
- Settings defined connections (orange) — these connections are predefined and depend on block settings;
- Buses (wide orange line) — buses also depend on block settings. All buses are 8-bit wide.
All blocks can be moved using mouse or keyboard (Ctrl+Arrow Keys or Alt+Arrow Keys) and rotated. You can
move a few blocks at the same time by using multiple select option. Rotation, flipping and alignment is also
available for more than one block at a time.

Dialog Semiconductor www.dialog-semiconductor.com
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3.1.4. Properties Panel

Properties panel contains all settings available for selected chip component. The panel is divided in two partitions:
Properties and Connections. Properties division contains settings and parameters that could be specified for a
selected block. Connection division contains settings which control the predefined connections to the selected
block. Last division could not be present in some blocks. Some parameters and settings are common for a few
blocks. There are 2 types of controlling elements Edit Box and Drop List. To change settings in Drop List you
can click *! and select action or place the mouse pointer over selected list and scroll by mouse wheel. To enter
value into the Edit Box you can use keyboard, mouse scroll or buttons at the right. After finishing all configurations

press Apply button to confirm changes. If you want to discard changes you can press Reset button @ with
options: reset settings to default or reset connections to default.

3.1.5. Components List

The Components list is an instrument that contains all blocks available in chip. It provides user with the possibility
to show/hide unused blocks. You cannot hide blocks that are connected by any type of lines. In the GreenPAK
chip there are connections which are beyond the connectivity matrix. They are controlled by settings of proper
components and cannot be fully disconnected. That's why there are some blocks that cannot be hidden. Hidden
blocks retain their configuration. For this reason, be sure to configure hidden components properly. You can
show/hide selected blocks by using the check/un-check feature on the list. In order to show a group of blocks,
double-click on the check box of the desired group. In order to hide a group use a single click.

There are two buttons at the bottom of the components list — Show all (shows all blocks) and Hide all (hides all
blocks which are not connected to a circuit). Also user can use filter to find required components.

User can drag&drop any component from Component List to the workarea to the right place:

|+ Components List ®

Components
+ PIN 20
= Logic gates
INv1
=1 Combinatorial Logic
2-bitLUT4
2bit LUTS
* 3-bit LUT1 © ' 3-hitLUTD
b P s | — 3hitLUT4
FhitLus
3.1.6 Color Scheme
Components:
Mode Description
Normal Selected

L | |Tumedon
% Turned off
L oPap

Components Pin Tips:

1]

Color Value

User can connect wire to this pin

Pin has already been connected (and there cannot be any other connections to this pin)

User can connect wire to this pin only after changing component option

Inner connection, user cannot connect wire to this pin

L

External 1/0O Pin (I/O from chip)

Dialog Semiconductor www.dialog-semiconductor.com
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3.2 Creating a Project

To create a new GreenPAK Designer project start GPD Launcher or go to File->New or click the “New” icon
on the toolbar. While creating new project in GreenPAK Designer please choose chip revision for current project
and specify operating conditions — VDD and Temperature.

Figure 3-4. Set Chip Revision and Operating conditions.

Specs | Informati

The SLG46620V provides a small, low power component for P matien

commenly used mixed-signal functions. The user creates their drcuit Operating condition:

design by programming the one time Non-Volatile Memory (NVM) to Min Tvp. Max
Select GreenPAK4 chip revision: configure the interconnect logic, the 1/O Pins and the macro cells of , i .

= the SLG46620V. This highly versatile device alows a wide variety of VDD (V): [ 1.80 I%] [3‘30 }%I [ 5.00 }%I

SLGA6620V - mixed-signal functions to be designed within a very small, low power

single integrated dircuit. Temperature (°C): | -20 SIES 2 a0 = @

A new project will be created in current window and all unsaved changes will be lost. Also you can start a new
GreenPAK Designer copy and it will be loaded with the blank project. By default the project is configured for
minimal power consumption and some components are disabled. All disabled components are darker and colored
in red after selection. GreenPAK 3-6 projects use [.gp3,.gp4,.9p5,.gp6] file extension. It contains information about
position, rotation/flipping and configuration of chip blocks, all wire connections, and bit file sequence settings of
test mode, etc. Interface settings will not be saved in the Project file.

3.2.1 Updating Existing Projects

If you load an existing project created by a previous version of GreenPAK Designer and want to save changes, it
will be saved in the updated file format.

3.2.2 Lock NVM Window

Figure 3-5. NVM Options.

o

VM Options
Lock status:

Pattern ID: 1

OK

), Detailed |
¥ Info

Lock status — blocks NVM reading. A programmed project becomes unavailable for chip reading. Though chip is
still applicable for the emulation.

Pattern ID — gives an ID (1-255) to the project. The ID will be put in the chip after programming, and also will be
read back during “chip reading” operation.

Dialog Semiconductor www.dialog-semiconductor.com
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3.2.3 Project Settings Window

Fiiure 3-6. Pro'|ect Settinis General tab

General | Seauity { Reqgulator and Charge Pump automatic OMOFF {use For dynamical 1.71Y < YDD < 5,5Y range)
Regulator auta OM/OFF and Charge Pump always OFF {use for 3.0% < YDD < 5.5%)
General project opt
SECl T ] Regulator auta OM/OFF and Charge Pump always OB {use For 1,71Y < YDD < 3.0%)
;a;vd:r Supply Control VDD directly to analog blocks (use for VDD < 1.9V) ~
GPIO quick charge | Disable -
'\s/‘ T oK Cancel

GPIO quick charge — this option will temporarily enable 2k resistor for ~1us duration in parallel to internal pull-
up/downs during power on, before reset signal is released to internal blocks. For example, this option should be
used to ensure the internal pull-up rise-time is fast enough to be detected as high level during power-on.
Otherwise, a rising edge with weak internal pull-up can be quite slow, and miss detection as a high-level because
of too slow of risetime.

Figure 3-7. Project Settings Security tab

General | Security

NVM Options
Lock status | Unlocked ~

PatternID |1

() Detailed ‘
W Info

Lock status — blocks NVM reading/writing. A programmed project becomes unavailable for chip reading or for chip
writing via 12C Tools for chips with 12C Serial Communication (see chip datasheet). The chip is still applicable for
emulation.

Pattern ID — gives an ID (1-254/65534) to the project. The ID will be put in the chip after programming, and also
will be read while “chip reading” operates.

Dialog Semiconductor www.dialog-semiconductor.com
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3.3 Configuring Chip Components

3.3.1 Placing Components

When you open GreenPAK Designer it will start with a blank project. A blank project contains pins and blocks
which cannot be hidden. Components can be moved, rotated, flipped and aligned. In order to move a component,
simply drag it where you want by clicking the left mouse button. To rotate/flip/align component select it and press

R # |

A \ o =
the “Rotate/F”p/A"gn" buttons Rotate Left RotateRight Flip Horizontal  Flip Vertical Align Horizontal  Align Vertical on the toolbar or SeleCt
Rotate/Flip/Align in the main menu.

3.3.2 Setting Chip Components Parameters

Each chip component has different parameters. Some components have parameters that are shared with other
components. Changes in one block cause changes in other blocks. Component settings are available at
component Properties panel (Figure 3-8) which appears after double-clicking on the component. Properties
panel consists of three parts: Properties, Connections, and Information. Properties section contains all settings of
a selected component. Connections section allows you to configure connections that couldn’t be made using
wiring tool. Information section contains short information about parameters of selected component. After making
changes in Properties panel click the “Apply” button to save changes. If you do not click the “Apply” button and
select another block, a save changes message box will appear.

Figure 3-8. Properties Panel

Properties 3]

ACMP2
1uA pullup on — -
input: = -
Hysteresis: Disable S
Low bandwidth: |Enable H
N+ gain: Disable S
Connections
N+ source: PIN 13 s
IN- source: 50 my H

Set power control settings

k=l Apply

Reset settings to default
Reset connections to default

OK Cancel

Reset connections and/or settings to default: this option allows to reset NVM bits, components properties, wire
connections from/to component.

Dialog Semiconductor www.dialog-semiconductor.com
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3.4 Specifying Interconnections

You can interconnect chip components to achieve the necessary functionality. To make a connection please select
&

Set wire =« on the Wire toolbar or from the main menu. Next, click the first and second pins that you want to

connect. After selecting the first pin, GPD highlights allowed connections in green. If you click the first pin and
then decide to exit line creating mode press Esc or the right mouse button.

Figure 3-9.

Also you can manually correct the created wires.
You can move horizontal lines up and down, vertical lines left and right (Figure 3-10).

Figure 3-10.

You can move points on the wire (Figure 3-11).

Figure 3-11.

In order to create additional points on the line use the double click (Figure 3-12).

Figure 3-12.

Only the green color pins can be connected Using Wire Creating tool. Some components have pins that are not
allowed to be connected using wiring tool. Connections between such pins (orange dotted line and violet pin
color) and buses can be made only by changing settings in Connections section of the Properties panel of

Dialog Semiconductor www.dialog-semiconductor.com
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proper components. In this case violet pins can change color to green and user can connect them using wiring
tool. Orange wires will be automatically generated. Orange wires also can be modified by user. Input pins without
connections are considered to be tied to ground.

In order to delete wire please select Erase wire = at the Wire tool-bar and click on the selected wire. Only
green wires can be deleted.

Additional controls for add/remove wires:
Hold button to force wire mode:

® Shift: for Set Wire;

® Alt: for Erase Wire;
Action with multiple wires:

® Hold Ctrl+Shift and click on pin: add multiple wires from the same source pin;
® Hold Ctrl+Alt and click on wire: remove all wires from source pin;
® Hold Ctrl: works as Ctrl+Shift or Ctrl+Alt based on current wire mode;

Move network
Move network feature provides the fastest way to reconnect all matrix wires from any pin to another. Simply click
on wire with right mouse button and select Move network in Context menu

Figure 3-13. Move network in Context menu

Convert to labeled connection

Convert network to labeled connection

Maove network

Remove connection
Remove network

Select new source from list in Move network window. User can select new source only from list of visible blocks or
from list of all blocks.

Dialog Semiconductor www.dialog-semiconductor.com
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Figure 3-14. Move network window

Select new source

¥ 1/0 PADs

LA A A A A L L & 4

VDD (PIN 1)
PIN 3

PIN 4

PIN 5

PIN &

GND (PIN g)
PIN 10

PIN 11

PIN 13

* (Combinatorial Logic
¥ 4-pit LUT2

* Analog Comparators

»
»
4

A CMPO
A CMP1
A CMP2

* Spedial components

P DLY
POR
QsC0
Qs
12C
Function

reyvvrvyvylDwvwwwwy

FILTERQ/EDGE DETO
FILTER1/EDGE DET1
2-bit LUTO/DFF/LATCHD
2-bit LUT1/DFF/LATCHT
2-bit LUTZ/DFF/LATCHZ

Visible blocks only

3.4.1 Wire Types

Green lines in GreenPAK Designer software tools are used to mark manual wires. Using them you can manually
connect necessary blocks to operate in the desired way. You can connect block output to multiple inputs, but
wiring of different outputs to one input is impossible.

Figure 3-16. Orange Line

Orange lines are used to mark the internal functional bounds of the chip blocks. They do not have the impact on

Figure 3-15. Green Line

chip operation until the proper function is used. These lines can’t be erased.
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Figure 3-17. Bold Orange Line

Bold orange lines (like the orange lines) mark the internal bounds. The difference is that the bold orange lines
mark 8-bit parallel data buses. These lines also cannot be erased. They do not have an impact on chip operation
until the proper function is used and the proper option is set.

Figure 3-18. Light Green Line

Light green lines are used to mark the shared connections. Their behavior is the same as the green lines.

Replacing wires by labels

This option converts wired connection to 2 labels (for output and input pins) and back (Figure 3-19). Name of the
label will be generated automatically: NETx, where x — random number. If output was connected to few inputs all
of them should have the same name. For changing the connection type use the context menu of the block, line or
label(NET).

Figure 3-19.Labeled connections

Available options for wire (context menu):
- Convert to labeled connection;

Available options for label (context menu):
- Convert to wired connection;

- Rename network;

- Remove connection.

Dialog Semiconductor www.dialog-semiconductor.com
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3.4.2 Set/Erase Label

Using Set/Erase Label the user can add/delete text label. The Set Label tool adds a text label to the selected
component or without connecting them to the specific component. The user can Attach label to component or
Detach label(s) from component(s). If no component is selected, then the user can select a component from the
list offered by the Set Label tool. The user can also choose text color. If the selected component already has a
label, Set Label tool can edit label text. If the user selects more than one component, it is possible to change the
text color without changing text in all components at once. If the user changes the text while more than one
component is selected, it will be changed on all selected components at once as well. Erase Label deletes text
label.

Fiiure 3-20. Add Label

+| Attach to block

[Pmi3 )l

Enter text

e I e
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3.5 Specifying the Pinout

3.5.1 Port Connections
Pin blocks can be connected just like any other blocks using the Wiring Tool.

3.5.2 Port Drive Modes

GreenPAK chips have GPIO, GPO and GPI pin components. These components can be configured to work in the
following modes:

— Digital in with Schmitt trigger;

— Digital in without Schmitt trigger;

- Low voltage digital in;

- 1x push pull;

- 2x push pull;

— 1x open drain NMOS;

— 2x open drain NMOS;

— 4x open drain NMOS;

- 1x open drain PMOS;

- 2x open drain PMOS;

- 1x 3-State Output;

- 2x 3-State Output;

— Analog input;

— Analog output;

Also, Pull-Up/Pull-Down resistors are configurable. To configure the pin component, open its parameters to set a
desired mode and pull-up/pull-down resistor. 1/0O pin components have input (IN), output (OUT) and output
enable (OE) pins. These pins are one-way directed, so you need to configure the pin component and connect the
proper pin. OUT pin is an output signal from the pin component. It corresponds to the signal from the input buffer.
IN pin is an input to the pin component. It accepts a signal from internal components. Output Enable (OE) signal
defines the Push-pull buffer state. Low OE signal switches buffer to Hi-Z state. High OE signal enables Push-pull
buffer regardless of selected component operating mode. It could be used for applications where bidirectional pins
are needed.

Dialog Semiconductor www.dialog-semiconductor.com
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3.6 Navigation

To navigate through project workspace use the View menu or toolbar. Use Zoom In "'-;s, Zoom Out =\ buttons or
slider to zoom workspace. If you want to see all project components click on Fit work area *< or Zoom 1:1°\.

To navigate through work area you can use Pan mode /. Pan mode also activates by using middle mouse
button.
To enable block's hint, press Show item hints .| button. A hint box pops up next to the item when the mouse

moves over the block.
== (RS (T)
3.7 Keyboard commands

To navigate through GreenPAK Designer use specific keyboard commands or shortcuts. List of commands
specified in the table:

Table 3-1. Keyboard commands

Keyboard command Action
Block moving on the scene
Alt+Arrow Keys Moves selected block on 1 pixel
Ctrl+Arrow Keys Moves selected block on 10 pixels
Connecting/Erasing wires
Hold Shift Forces Set wire while using Erase Wire
Hold Alt Forces Erase wire while using Set Wire
Hold Ctrl+mouse cursor Adds multiple wires from the same source
Hold Ctrl+Shift+mouse Forces add of multiple wires from the same source while
cursor using Erase Wire
Hold Ctri+Alt+mouse Forces remove of all wires from the network while using Set
cursor Wire
Standard hotkeys
Ctri+Z Undo
Ctri+Y Redo
Ctrl+N New project
Ctrl+O Open project
Ctrl+S Save project
Ctrl+P Print Editor
Ctri+Q Exit program
Ctri+L Rotate component Left
Ctrl+R Rotate component Right
Dialog Semiconductor www.dialog-semiconductor.com
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Ctri+H Flip component Horizontal
Ctrl+Vv Flip component Vertical
Ctri+W Set Wire

Ctrl+E Erase Wire

Ctrl+F Filter on Components List
H Hide component

+ Zoom in

- Zoom out

F1 Help

F2 NVM Viewer

F3 Properties of component
F4 Components List

F5 Rules Checker

F9 Debug

F11 Fullscreen Mode

Debug hotkeys

Shift+E Emulation
Shift+l Info

Shift+L Log

Shift+N NVM Data
Shift+P Program
Shift+R Read

Shift+S Save Settings
Shift+T Test Mode

All other Designer main window actions can be configured by entering specific key sequence in Settings window

on Shortcuts tab. For ASM Editor user should enter key sequence in format: Ctrl+key.
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3.8 GreenPAK Designer Settings

GreenPAK Designer settings configure all basic options of program in several tabs (Figure 3-21). To open settings
select Options-> Settings in main menu.

Figure 3-21. Settings window

General Designer Appearance Shortcuts Updater
Default projects folder
C:\Users\Bogdan | Browse...

Projects recovery

Turn on autosaving

T a
(save & copy to temporary location) Frequency: |5min |+

Default Ok Cancel Apply

GreenPAK Designer settings window contains of tabs:

General:
® Default projects folder — defines path to users GPD project files;

®* Projects recovery — activates autosave function, which allows to reduce the risk or impact of data loss in

case of a crash or freeze. Autosave function in predetermined time intervals will save your files and after a
critical problem will offer to restore these files in GreenPAK Designer Launcher on Projects files recovery
tab (Figure 3-22);
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Figure 3-22. Project files recove

tab in GPD Launcher

Welcome

" Project files recovery

Name Type Date Modfied ¥ Date Created
lmﬁ 6072autosave.gpd gpd 240520171403 240520171402
aay
3
PP 2 “5 | ~o106autosave g5 ges 240520171400 240520171338
3% BdT6autosave.gp3 gpd 220520171448 18.05.2017 16:41
Demo
What's New
Recovery
Datasheets
[EX T Total files found: 3 ZRefresh [ = Load [saveas | | Remove I KRemoveaH[ Close
[ ]

Pin hints — shows pin hints while block is selected or properties panel of component is visible:

Appearance:

work area;

Window appearance — saves positions of toolbars/dock widgets and window geometry of GP Designer
o

High DPI displays — enables GP Designer scalling on high DPI displays;
Shortcuts:

Updater:

On Shortcuts tab all GP Designer actions can be configured by entering specific key sequence. For ASM
Editor user should enter key sequence in format: Ctri+key;

Scheduler — determines check for updates time: after Designer starts or Once per 1-7 days;
[ ]

Path — defines server for update and destination to download updates;

Proxy — allow user to configure proxy for updates;
[ ]

Check configuration button — checks connection to server.
Default button:

Resets settings to default parameters by categories or all at once.

Dialog Semiconductor
12/19/2019

www.dialog-semiconductor.com
27



¢dialog

SEMICONDUCTOR GreenPAK Designer 6.21

3.9 Legend Box

Legend box shows the color scheme of GreenPAK designer.
The user can open this window by clicking 'Legend box' button in 'Help' menu.

Figure 3-23. Legend Box View

e dependent
red connecti
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3.10. Updating GreenPAK Designer
There are two ways of updating the GreenPAK Designer:
®* When updates are available — this information will be displayed. The user will get a chance to either

download a new version using the “Update”, or the “Not now” to delay the renewal until the next program
start. After the download is finished, an opened folder with installer will appear.

Figure 3-24. Updating GreenPAK Designer

= [SLG46721V] - GreenPAK3 Designer v.4.03 -

File Edit View Tools Options Help
» B8 $:x BN ®m B B S

[T Iy -r
e Pt - Setwire Vire - Setlabel Eraselsbel - RulesChecker  Emuator ~ ProjectSettngs  Projectinfo - Properties Components VM Viewer - Datashest Examples User Guides

New

[*Rotate Left  “]\ Rotate Right Fi Fipvertical (] A tal | Align Vertial

- GreenPAK Designer Updater

No updates are avaiable
You are using the latest version.

®* You can also find the latest GPD version at Software page of Dialog web site. For the best user

experience, keep your GreenPAK Designer up to date. Feel free to email suggested updates to the
developer to improve this program (Please refer to “About GreenPAK ” section of Help menu).

Configure Updater options on Updater tab in Designer Settings window (see Section 3.8 GreenPAK Designer
Settings)
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3.11 Help Window

To view information about a specific block, select the block and click 'Help' from the Help menu or press the 'F1'
button. A window will list the information about each block ('short info'). Press the 'detailed info' button for more
detailed information (Figure 3-25). If you don't select any block, you will be shown the information about all the

blocks. The 'Help' button on the property panel of each block provides the same information about the current
block.

Figure 3-25. Help Window

File Edit View Tools Options Help

H*ﬁ‘;x‘l‘y/éiaﬁ*'\%’?‘ﬂ©

New Open Save  Prit = SetWre FEraseWre - Setlsbel FEraselabel - RulesCheder  Emuiator - ProjectSettngs  Projectinfo - Properties | Components | NVMViewer - Datasheet Examples User Guides

/" Rotate Left . Rotate Right Fip Horizontal FlipVertill 1] Align Horizontal | Align Vertical

Components List ®

Components
=1/0 PADs
V| voD

[v)

v P2
v PIN3
v PNg
v PINS

ﬁ GreenPAK3 Reference (SLG46721V) v omie

v
=I- GreenPAKS3 Reference (SLG46721V) PIN 10

oy GreenPAK3 Reference (SLG46721V) e
LUT (Look-up Table)

I . v
LUT/DRF/LATCHes Detailed information vt
LUT/PIPEDELAY Feat Y
COUNTER/DELAY ures: 4 signal ¥ PIN 18
e ~Logic &Mived Signal Crauits Y| PIN 19
; e Delay/ Edge Detects ~Highly Versatie Macro Cells ¥/ PIN 20
rogrammale Delay / Edge Detector -Read Back Protection (Read Lock) =l Logic gates.
Additional Logic Functions 18V (£5%) to 5V (+10%) Supply

ACMP (Analog Comparator) - 1.8V (£5%) to 3.3V (+10%) Supply (when using the 2MHz internal OSC)

Voftage Reference (VREF) - Cperating Temperature Range: 40°C to 85°C = Combinatorial Logic
Power on reset (POR) -RaHS Compiant / Halogen Free 2Ll
RC Oscilator (RC 0SC) - 20+pin STQFN: 2x 3 0,55 mm, 0.4 mm pitch

2bitLuUTS
y 3bitLuTo
Applications: SbitLuTt
~Persanal Computers and Servers TotiuTa
3bitLuTs
Data Commncatons Epment preinid
“Hanheld and Portable Eectronics 3bitLuTa
The GreenPAK3 SLG46721is Slego’s third generation GreenPAK produict and i 3 one-tme programmable Mixed-Signal Array coming in a smal 2 mm x 3mm = Analog Comparators
TORN-20 package. AvP1
The GreenPAK3 operates at a 1.8V to 5V low power companent for mived-signal functons. A2

Users aeate their programin Jatle Memory (NVM) 1OPINs and macrocells of the SLG46721, This e Lo
isecsignal funcions to yamal, lon parier Lantampi
8-bit CNT4/DLY4
8-bit CNT5/DLYS
8-bit CNTE/DLYE
= Special compenents
FILTERD

FITERL
05¢
PDLY
VREFO
VREF1

POR
= Combination Function components
2Zbit LUTO/DFFALATCHS
2bit LUTL/DFF/LATCHS
2bit LUT2/DFF/LATCHS
2bit LUTSDFF/LATCHT

3bitLUT2IDFFLATCH2 =
3bit LUTS/DFF/LATCHS
3bit LUTE/Pipe Delay

G
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3.12 Demo board and Demo mode

Demo board

Demo board is a special hardware with a mission to demonstrate some specific application of GreenPAK chip.
They have GreenPAK chip soldered on the board, already programmed with some specific project. They also
support 12C transferring that allows Designer to communicate with GreenPAK chip and change it NVM.

The exception is 12C Bridge which doesn’t have specific project and allows any project to be loaded in.

Demo board connection
After opening of Demo project, Designer waits for connecting of proper device:

Figure 3-26. Waiting for proper Demo board

File Edt View Tools Options Help

wHe= Y © B8 & & XK B N =&

Mew Open Save FPrint  SetWre |EraseWire  Setlabel Fracelabsl  RuesChecker Emustor  ProjectSettings  Projectinfo  Properties | Companents | NVM Viewer

" Rottzleft ) RotateRight |\ Fip Horizontal Fiip Vertical | Align Horizontal = Align Vertical
M bits vies
(TN | ] T T | T T T TN 1 TSI [T 1l

51 50 49 48 47 46 45 44 43 42 41 40 39 38 33} 36 35 34 33 332 3N 30 29 28 27 26 | 25 |24 |25 2 2 20 19 18 17 16 15| 4|13 |12 1 10 9 8 7 6 5 4
» © @ © ¢ o © © ©0 ©0 ©0 © © © 0 9 0 0 © © ©0 ©0 O © © @ © © 0 © 0 © ©0 o 0 © © © © @ @ o 0o 0 0o 0o ©° O
[

Propertes ®
el I@ Please connect Silego GreenPAK System Reset Demo Board to USB port. Close I

Demo board detection

Figure 3-27. Demo board detected

E0= Y O B ¥ 3 £ B2 0N =m =2

Wew Open Save Frint  SetVifre Erase\Wie |  Setlshel Eresslsbel  RuesChecker  Emustor  ProjectSeiings  Projectinfo | Properies  Components | VM Viewer

" Rotateleft ) RomteRight [\ Fip Horizantal Fpvertical ] Algn Horizontal [ align Vertical

T | [Nl | TN | I | [~ T T [ I

51 50 46 48 4T 46 45 44 43 42 #1040 39 38 37 36 35 M 33 | 32 31 30 2% @ N ¥ 5 4 B 2R N | 0 19 1w 17T 16 15 14 13 12 1 LI ) 8 7 6 5 4

Propertie: ) I
2 I Wirite I2C Input || 12C Oulput B g I

After Proper Demo board detected (Figure 3-27), simple 12C tool activated:

* Write - sends current project’'s NVM to device;
® |2C Virt. Inputs, I12C Virt. Outputs - opens 12C tools;
® (Close - exits demo mode;

® Info button - shows all system and hardware information;

Designer’s Demo Mode

User can start designer in Demo mode, which means it will show specific project for selected demo and provide
tool to operate with demo board. Demo mode applies some restrictions on Designer functions as well as adds of a
new features. In general case it opens specific demo project, shows specific tool control panel and limits
operations with project file.

Exit demo mode

User can exit demo mode. This will decline all restrictions applied by demo mode, but keep current project open.
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3.13 Snipping Tool

Snipping Tool is screenshot tool for GreenPAK Designer workarea. It allows scene selection, copying or saving as
a file.
Click Tools — Snipping Tool, select style of screenshot area (Figure 3-28)

Figure 3-28. Snipping Tool window with style selection

Options

(®) Datasheetstyle | Regular style

Select area and copy to clipboard or save image in Bitmap/PNG/SVG format (Figure 3-29)

Fiiure 3-29. Sniiiini Tool window: exiort selection

Preview Copy

| Copy as bitmap |

| Copy as SVG |

Save

| Save as PNG |

| Save as SVG |

Close
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4. Print Function

4.1. Print Editor
Print Editor feature consists of two main parts:
& Editable working area, where the user can customize positions, view of components, and lines
connecting them.
& Preview window where the user can set up the print preferences.

Editable working area shows all components which where used in the design.

Figure 4-1. Print Editor
LE Print Editor M=

File Edit Wiew

= % = & & L A A | B @® Ly 8
Print  Preview Saveimage  Snapshat Rotate Left  Rotate Right  Flip Horizonkal  Flip Vertical Add Text | AddRect  AddElipse  Graphics settings

-

P I N 1 1 X Components

in s

Mode: Digital in without Schmitt trigger __I_ ¥ Combimatorial Logic
Jext  Res.:Pull Down = o iwatches

infout Res. val.: 300K

¥| Analog Comparators
+| Digital Comparators
| Counters / Delays

| Special components

F [+

Init. state: Output floating auil-
B
=
PIN 10 :
in

i

Mode: Digital in without Schmitt trigger
et Res.:Pull Down
iUt Res. val.: 300K

Init. state: Output floating auil

[l 20

(1]

(4] D)
===+ [R )& T)
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The Main Actions:

- User can hide or display any component using the Components list on the right.
- Each component in the work area is selectable and movable.

- Any component can be rotated or flipped.

Note: print editor settings will be saved before print editor's window is closed. It allows the user to repair previous
state during next opening.

You can load previous print editor state or reset all blocks.

Do you want to load previous print editor state?

ok | W piscard || 3 cancel

Figure 4-2. Preview Window

LE Print Editor BEX|
File Edit View
= - a i 2 S| i A B @ L, 4
Print  Preview Saveimage  Snapshot Rotate Left  Rotate Right  Flip Horizontal  Flip Wertical Add Text  AddRect  addElipse  Graphics settings
[a]u} ] Components
r in+ =« I/0PADs
shared DC &3 Combinatorial Logic
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Figure 4-3. Preview Window
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Figure 4-4. Work sheet.
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Working area
Working area can be zoomed in or zoomed out.

User can add a text label to the schematics using the text tool.
Figure 4-5. Text Label

Input text her
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Figure 4-6. View with Text Label
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The user can add to the working area the custom figures including rectangle, rounded rectangle, ellipse etc.

Figure 4-7. Custom Figure

The user can also customize the main paint parameters.

Figure 4-8. Paint Parameters

¥: Drawing Settings il |
l_ RN ——
e ) et e
Pen Width: |3 E
Pen Style: IDash 'l
Pen Color: Iblack 'l
Brush Style: ICross Vl

Brush Color: Ispringgreen :

W - |
ok steelblue

tan
D . teal I

thiskle:

. tomato

transparent

Eurguoise

wiclet

wheat

white =

You can see a small preview window which includes a painted rectangle with user-parameters.
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When the user adds a figure to the working area, one can customize the figure size by dragging black points on
the corners and sides. The user can view it only by moving the mouse pointer up to the figure.

Figure 4-9. Work Area

PIN 3

Mode : Digital in
ext. iniout  Resistor : Pull Down
Resistor value : 300K

L

PIN 4
Mode: Digital in
Resistor: Pull Down
Resistor value : 300K
Open drain x2 : Dizabled

ext. indout

1 ]
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The user can save a composed diagram into a graphics file or directly send it to the printer.

Figure 4-10. Save diagram
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4.2. Print Editor Preview Window

Preview window shows the composed and ready-to-print diagram. In this window, the user cannot change the
position of the components or the other elements in the diagram. The user can only choose the advanced settings
for printing or saving to the file.

Fi%ure 4-11. Preview Window

= = & [ M'ﬂ (v #] B & «
= Print  SawePDF  Save Image

Page Setup  Portrait To Center Real Size Project Data  Edit Data Zoom In Zoom Ouk
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Main Actions
The user can:

Choose orientation of the diagram on a paper (landscape or portrait)
Fit the diagram to a page or keep the real size

Fit to center

Zoom in or zoom out

Choose the size or type of paper

Save the finished diagram into a PDF/Image file or print it out

Figure 4-12. Page Setup

: Prinkt Preview

ClAE P ESEYE S =

— Paper
sie I -
Source: IABTomaTuHBCKMH BbIGop ;I
— Orientation Marging [millimeters]—————————— 1 |"I i
" Portrait Left: |3,E|8 Fiight: |4,15 TR }
!
i+ Landscape Top: 5.55 Bottom: |3,88 r £
Qk I Cancel I Printer.... |
L l J
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4.3. Print

Print window shows the composed and ready-to-print diagram with block properties and its values. In this window,
the user cannot change the position of the components or the other elements in the diagram. The user can only
choose the advanced settings for printing or saving to the file.

Figure 4-13. Print window with block properties and values

s & D A & &
Prit SavePDF Savelmage  PageSetup Portrait ToCenter | ZoomIn memM

yyyy

Print options:
® Choose orientation of the diagram on a paper (landscape or portrait)

® Fit diagram to center

® Zoom in or zoom out

® Choose the size or type of paper

® Save the finished diagram into a PDF/Image file
® Print diagram and block properties
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5. Rules Checker

This tool allows checking current project errors, for example, incorrect block connections or settings. Rules
Checker has three types of messages:

@ ril - this message is generated when there is a significant error in design that will not work under any
conditions.

<& wemning - this message is generated when one or more blocks may contain incorrect connections or settings in
the design. This does not mean that there is an error. It only notifies the user to check the connections or settings
of the blocks.

@ nte - this message is generated to remind the user to check for correct settings.

Figure 5-1. Rules Checker Output

File Edit View Tools Help
B = F | X &4 ' = Yz & - & ¥ B kel
- fis 2 \ . . . R b .
New Open Save Print SetWire | Erase Wire Rotate Left RotateRight  Flip Horisontal  Flip Vertical Setlabel  Erase Label Rules Checker Mini-Emulator  Emulator Lock NvM Proper nents Datasheets  Examples
I Properties ® Components List ®
PINS Components
| = 1/0 PADs [a]
Hode: ¥ Yoo M
¥ PIN2
Resisor v ma
Resistor value: : ;%:g
¥ GND
iti: Outputfloatng % ¥ PINB
¥ PIN9
OE: From matrix < : ;%: i?
+ PIN 12
PIN 2 = Combinatorial Logic
2-hit Ll
Reset: Disable = 2-bit LUT1
2-bit LUT2
Bypass: Edge active A ﬁ:t tgrg
3-bit LUTL
Edg; detect [ pising edge Y H::tLUTZ
e 3hitLUT3
" 3bit LUT4
Information H::t e
Flectrical Specifications & o J.l;:';‘,t‘;m’
DFF/LATCH 0
18V 33V 50V DFF/LATCH 1
min/max min/max min/max DFFJLATCH 2
DFF/LATCH 3
V_OH 1660/-- 2100/-- | 2.800/-- = Analog Comparators
¥ ACMPO
v.oL --/0415 --/0810 --/2200 ACMP1
~I- Digital Comparators | PWHM
10OL 0340/-- 1836/-- 2.745/-- DCMPO/PWMO
DCMP1/PWM1
Far mare information please refer to the DCMP2/PWM2 —
datasheet = Counters | Delays
CNTO/DLYO
CNT1/DLY1
CNT2/DLY2{FSMO
CNT3/DLY3/FSM1
Ml Detaled = Special components =
| 1 s 5] Apply - - anr =
e (5 )(). (7]
Rules checker output ®
Time Event Rule Note
22:39:13 @ Fail PIN 5: OE is not connected OE from PIN 5 is not connected. So output is cenfigured as ‘Push Pull’
22:39:13 @ Warning PIN 3: Incorrect 'Mede' option PIN 3 has incorrect mode. Made option should be set as 'Analog In'
22:39:13 <> Warning PIN 5: Resistor value' is not ‘Floating'  Floating resistor value is recommended for 'Push Pull' mode ta lower power consumption
22:39:13 <> Warning A CMPD: output not connected Block's output is not connected to a circuit
22:39:13 @) Mote  POR: ckeck 'Power Supply Control mode One of the analog blocks is turned on. Check POR 'Power Supply Control mode settings for correct setting
Checking is done with: 1 fails, 3 warnings and 1 notes.
In order to check the design, click the Rules Checker button on the tool bar in Tools menu.
Rules Checker Window can be called by clicking Rules checker output in View menu.
Rules checker output consists of three parts:
1. Event—shows message type (Fail, Warning, Note).
2. Rule — information about the message.
3. Note — recommendations on how to correct the error or error explanation.
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6. GreenPAK Debug Tool

Figure 6-1. Debug Panel and Debugging controls in GreenPAK Designer
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Debugging controle E

Import confiauration

o o change platform
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Device: | Onbosrd 12C Reset

Read

Cmuation |~ Testbode Frogem |-
Project Data
StarL Al Pause Al Stop Al

2[4 65 [10]12]14]16] 18 20]vb |22 2426 |25 30 | 32
val3 |5 |7 |s [Glslislirlis] l21l23|25|27]2s 51

Int.voo || Ext. voo on | [ore T vap

LEDs On | [LEDs oFF
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Debug

Debug button starts Debug tool in GreenPAK Designer (Figure 6-1). The Debug tool enables electronic circuit
emulation and chip programming, which uses specific hardware platform to replicate the behavior of chip
components included in GreenPAK. Before starting the emulation process, add test points controls to configure
the emulation process.

Type of hardware platform
After start of Debugging tools select type of hardware platform with supported features (Figure 6-2):

Figure 6-2. Platform selector window

GreenPAK DIP GreenPAK Advanced GreenPAK Pro

GreenPAK In-System
Development Platform Development Platform Development Platform Programmer

Software Simulation

Cancel
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Platfrorm Configuration Guide
Recommended Platform Configuration Guide contains information about suitable sockets, adapters and boards
for the specific chip. The user can pop up the guide by clicking on platform’s name into Debugging controls panel.

Designer v6.13 -8

File EGit View Tools Options Help

. i & L oo
] Q¥ l pay
B & g 3 © % & kS b 7 N R OE
New Open Save Print Undo Redo SetWire = Erase Wire Setlabel Erase Label Rules Chedker Debug | 12C Tools Project Settings Project Info Properties | Components | NVM Viewer
" RotateLeft “\ Rotate Right Flip Horizontal FiipVertical || Align Horizontal | Align Vertical AddVDD ¥ Remove 12C Virtual Inputs  12C Virtual Outputs.

| Debugging controls 8%

—— change platform

Development Platform

Import configuration

Device: | Onboard - I2C Reset

Recommended Platform Configuration Read
GreenPAK Pro Development Platform, SLG46826V . C— E—

Project Data
Start All Fause Al Stop All

24|68 [w[12]14|16]18]20|w 2
va|3 5|79 e 3]is]17]is

Int.vDD || Ext. V0D on | |oFF T Mzp

LEDS ON | | LEDs OFF

PN: -, DB HWFW: - 0=

Components List ®

Components
~ 1/0PADs -
¥/ VDD (PIN 1)
¥ PIN 2(100)
1 n ¥ PN 3 (01)
b 00 BI1331381380380 { | PIN4(102)
— ¥ PIN5(03)
) o B V| PIN6(104)
¥ PIN7(05)
¥ PIN 8 (SCL)
! o a dena)

Figure 6-2. Recommended Platform Configuration Guide
Add test points controls

Debugging tool controls are used to configure input signals on external inputs of chip (proper test points on
development platform).

To manage chip input signals:

® Use the context menu on input pin with right mouse button click on NC (not connected) symbol (Figure 6-
3).

LED Enabled
Connect to Expansion Connector
N/C

Voo

GND

Pull up

Pull down
Button

Logic generator

Copy settings to ]
Exchange settings with ]
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® Add control to TP with Add button on Debug panel (Figure 6-4). List of available controls on TP: Signal
generator/Logic generator/VDD/GND/Button/Pull up/Pull down.

Figure 6-4. Add button on Debug panel
&) Add Signal generator  |* §
® Signal generator
Logic generator
12C generator
VDD
GND
Buttan
Pull Up

Pull Down

Remove test points controls
Remove button removes test points controls by mouse click on it. TP become NC. Also user can set TP control as

N/C from context menu by clicking with right mouse button.
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6.1. Types of Areas

Fixed Inputs (Figure 6-5 — 6-9).
Figure 6-5. N/C (not connected)
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LED's (Figure 6-10)

, Buffered LED+Pull Down

Figure 6-10. Buffered LED, Buffered LED+Pull Up

Configurable Input (Figure 6-11)

igure 6-11. Configurable Button

The default connection can be set to either Upper connection or Bottom connection. Click your mouse over the
key U or B to change the value.
The user can configure each connection to VDD/GND, High-Z or Pull Up/Down.
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Figure 6-12. Default Key Connection

Upper connection 13
I
Default connection ] To Upper connection

Set 'Push’ hot key
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LED Enabled

Connect to Expansion Connector

Pull up

Pull down

Eutton

Logic generator

Copy settings to
Exchange settings with

Upper connection < | Upper connection ]

Bottom connection HIZ ~ f Bottom connection
Default connection Full up L==d Default connection HIZ

Latch mode Latch mode Full down

Set 'Push’ hot key Set 'Push’ hot key

The switch has 2 modes: Latched, Unlatched, which can be configured from the context menu or click your mouse
over the key LATCH to change the value.

Figure 6-13. Key Mode

Upper connection
Bottom connection
Default connection

Latch mode v | Mot latched

Set ‘Push’ hot key Latched
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User can assign Hot Key for 'Push' action. The assigned key will simulate mouse click over the key:

Figure 6-14. Choosing Hot Key

Custom key ...
Key 'Q
Key "W*
v Key'E'
Key 'R’
Key T
Upper connection
Key Y’
Bottom connection 4
Key '’
Default connection ¥
Key I’
Latch mode
Key 'Q"
Set ‘Push’ hot key Key P
LED Enabled Key ‘&'
v | Connecdt to Expansion Connector Key 's'
N/C Key D'
VoD Key 'F'
GND Key 'G'
Pull up Key 'H'
Pull down Key ')’
Button Key 'K'
Logic generator Key 'L’
Signal generator Key 'Z'

User can assign the same hot key to other Switches which allows changing the key values of all the Switches with
the same hot key at once.
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6.2. Generators
To defined TP can be connected 3 types of generators: Logic generator, Signal generator or I2C generator. User
can add generator with Add button to highlighted green pins or use context menu of the TP.

Figure 6-15. Choosing Generators

Led Enabled

Connect to Expansion connector
MN/C

VoD

GND

Pull up

Pull down

Button

Logic generator

Signal generator

12C generator

Copy settings to L3
Maove settings to L3

Exchange settings with b

Each generator has its own settings. For the settings window to appear press the Edit button or double click on S
or L or SDA/SCL symbol at TP.
On the left, you can see the options table divided into 2 groups:

1. General — applied to all types of generators

2. Special for each generator

Start all generators with buttons at Debugging controls panel (Figure 6-16)

Figure 6-16. Managing Buttons

Start All Pause All Stop Al
Note: these buttons can be controlled only by generators with an installed Global Linkage flag.

Figure 6-17. Global Linkage
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6.2.1. General Options in a Signal Wizard Mode

Figure 6-18. General Option

General

Generator: TPE (PING) - Sine

Shown period:
Start point:
Stop point:
Global linkage:

Auto
0.000
1000.000
Linked

Repeat: Cydic

Repeat count: 2

Pre-start state:
Pre-start delay:

Low
0.000
End state:
Output type:
Pause type:

Pre-start state
High-Z
Last state

Signal Generator Settings

Type: Sine

Phase: 0

Custom
phase:

Amplitude:
Zero offset:
Period:

0.00 rad

2751
2751
1000.000

Frequency: 1.00 Hz

Data:

Tolerance: £7 mV

Minz | 0.000

Max: | 0.010

Generator:

Shown period: Auto/Custom/1T/2T/3T/4T

Global linkage Linked/Unlinked

Repeat One shot/Cyclic/Custom

Prestart state Low/Start point(V0)/High-Z

Prestart delay

End state Keep last state/Prestart state

Output type High-Z/Strong Drive/Open Drain, Drives High/
Open Drain, Drives Low/Resistive Pull Up/
Resistive Pull Down/ Resistive Pull Up/Down

Pause type Last state/Low/High/High-Z

- generator selector

- set the period of a

current

generator to be displayed
-if generator is linked, it will be

controlled by buttons “Start”,
“Stop” and “Pause” on the

Debugging controls
- repeat option
-state before start
-delay before start

-pin state after generation

- type of output

-state when it is paused
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6.2.2. Period Modes
AUTO Mode
All generators with '"AUTO' option have one scale; this scale = MAX period of all generators with '"AUTO' option.

Figure 6-19. One Scale for All Generators

Options
General

Generator: TP (PING) - Sine

a5

Shown period: Auto
Start point: 0.000
Stop point: 1000.000
Global linkage: Linked

Repeat: Cydic
Repeat count: 2
Pre-start state: Low
Pre-start delay: 0.000

End state:
Output type:
Pause type:

Pre-start state
High-Z
Last state

Signal Generator Settings

Type: Sine

Phase: 0

Custom 0.00rad
phase:

Amplitude: 2,751
Zerooffset: | 2.751
Period: 1000.000

Frequency: 1.00Hz

Data:

Tolerance: 7 mv

Maoc: | 0.010 ms '@

Auto Apply k=) Apply All Start Pause Stop ®) Auto  Min: | 0.000 ms
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Figure 6-20. User Can Change the Scale Manually

Options
General

Generator: TP6 (PING) - Sine

Shown period: Auto

Start point: 0.000
Stop point: 1.550
Global linkage: Linked

Repeat: Cydlic

Repeat count: %

Pre-start state: Low 0.00
Pre-start delay: 0.000

End state: Pre-start state
Output type: High-Z
Pause type: Last state

Signal Generator Settings

Type: Sine

Phase: 0

Custom 0.00 rad
phase:

Max. voltage should b
Amplitude: 2,751

Zerooffset: | 2,751
Period: 1000.000
Frequency: 1.00 Hz

Data:

Tolerance: 7 mV

Auto Apply 5] Apply ‘ Al Start Pause Stop Auto Min: | 0.000 v||ms v | Max: | 1.850 <ls - | -@

button turns on/off the mouse coordinates in the timing diagrams.
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CUSTOM Mode

Figure 6-21. Choosing Period Options

Options
General

Generator: TP6 (PING) - Sine hd
Shown period: Custom -
Start point: 0.000 | |ms -
Stop point: 3.500 vl s -
Global linkage: Linked -
Repeat: Cydic -
Repeat count: 2

Pre-start state: Low =
Pre-start delay: 0.000 | | ms ~
End state: Pre-start state

Qutput type: High-Z

Pause type: Last state -

Signal Generator Settings

Type: Sine =
Phase: 0 d
Custom 0.00 rad

phase:

Amplitude: | 2,751 =l v -
Zerooffset:  2.751 </ |v -
Period: 1000.000 ~ | |ms 7
Frequency: 1.00 Hz

Data: Modify

Tolerance: 7 mV

Auto Apply S Apply Al Start Pause Stop ) Auto Min: | 0.000 ms Max: | 0.010 ms )
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6.2.3. Logic Generator
F

igure 6-22. Logic Generator

Logic generatoris used for generating the logic pulses.

Figure 6-23. 'Edit' button allows configuring the signal.

Options
Stop point: 1000.000
Global linkage: Linked
Sync Power Rails: Disabled

Repeat: Cydic
Repeat counkt: 2
Pre-start state: Low
Pre-start delay: 0.000
End state: Prestart state
Qutput type: Push-Pull

Pause type: Last state

Logic Generator Settings

Mode: Normal

Pattern: 101101010111
T

500,000 ms

500,000 ms
500.000 ms
500.000 ms
500.000 ms
500.000 ms
500,000 ms
10| 500.000 ms

11| 500.000

E 500,000

Insert before row | 1

ms

A [0 | ([ [ || [

ms

Remove row 1

Levels count: 12

Auto Apoly (5] Apply Al Start Pause Stop @) Auto Min: |0.000 ms Max: | 0.010 ms @
Configuration options:
Mode: Normal/Invert - signal mode
Pattern: 0 — low/ 1- high level - pattern of pulse levels
Repeat: One shot/Cyclic/Custom - repeat option
T/Level: - sets duration of level
Insert: - insert pulse before selected position;
Remove: - remove pulse from the selected position;

Levels count:

- pulse count
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6.2.4. 12C Generator
Figure 6-24. 12C Generator

I12C generator allows a user to make an 12C signals based on logic generators. There are two logic generators
combined together as SDA and SCL lines. User can combine predefined 12C primitives to generate the needed
waveform in an appropriate way and choose SCL frequency.

SCL

Generates SCL signal applicable for 12C. SCL signal is the special kind of logic generator applicable only for
board configuration. SCL is only 'read-only'. The SCL clock configured by choosing predefined frequency. The set
of those frequencies depends on the development platform.

SDA

Generates configured SDA signal applicable for 12C. SDA signal is the special case of logic generator applicable
for sending data via 12C. In Signal Wizard special editor shows sequence of commands. User can do some
actions in command editor:

® change SCL pin for selected SDA;

® change Speed of 12C clock;

® control resource meter;

® Change Slave Address for all commands in list;
® Clear list to basic commands: Start and Stop;

® add or remove commands by using +/- buttons;
® change command parameters;

® split Composite commands in sequence of Basic commands by using button “S”;

Figure 6-25. I12C Generator commands editor

SCL: PIN3 [TP3] - 12C clock =
Speed: 1 kHz =
Used resources: 83%

Change Slave Address Clear

Start |5 |9 |=
Read r|Ss|d|=
Slave address: | 0x0 *| [hex ¥
Word address: | 0x0 || hex =
Byte count: 1 =
Write |5 |d&|=
Delay v|s|d|=
Stop |5 |dp|=
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Figure 6-26. 'Edit' button or double click on SDA/SCL allows configuring the signal.

Options
i General

‘Generator: PIM2 [TP2) - I12C Generator

Shown period:

Start point:

Stop point:

Global linkage: Linked
Sync Power Rails: Disabled

Repeat: One-shot

Repeat count: 2

Pre-start state: High

Pre-start delay: 0.000

End state: Pre-start state
Qutput type: QOpen Drain + Pull up
Pause type: Last state

12C Generator Settings

PIN3 [TP3) - 12C clock

1kHz

Used resources:

Change Slave Address

L Start
FAN Read

El Write |
El Stop

%
=

= = : i = = g < (ms)

Auto Apply

Configuration options:

SCL: Any available pin - selects pin to be the 12C clock channel
with defined frequency

Speed: 1-1000kHz - speed of 12C clock

Used resources: % - shows used resources after adding
commands to list

Change Slave Address hex - changes slave address in all commands

Clear - clears all commands from the list to Start
and Stop

Commands - list of 12C generator commands
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6.2.5. Signal (Analog) Generator
Figure 6-27. Signal Generator

Signal generator is used to generate analog signals: Constant Voltage level, Sine, Trapeze(Trapezoid), Logic
pattern and User-defined.

Logic and signal generators can be started/paused/stopped using orange buttons or through the context menu.
The user can also assign the hot keys for start/pause.

More than one generator can use the same hot button to start/pause at once. This is how to start more than one
generator at the same time.

Figure 6-28. Sets Start/Pause Hot Key

Start/Continue generator

Pause generator

Stop generator

Pause type

Custom key ...
Edit

Key 'Q'
Global linkage Key W'
Set 'Start/Pause’ hot key Key 'E
LED Enabled Key 'R’
Connect to Expansion Connector Key'T'
M/C Key "Y'
VDD Key 'L"
GND Key 'l
Pull up Key 'O
Pull down v Key'F
Button Key &
Logic generator Key 'S
Signal generator key'D

Key 'F'
Copy settings to

Key 'G
Exchange settings with

Key 'H
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Signal Generator Settings

Type: Const voltage level/Trapeze/Logic pattern/Sine/Custom

Constant value:
u:
Figure 6-29. Constant Value

Options
General

Generator: TP10 (PIN10) - Constant Voltage «

Shown period: Auto -
Start point: 0.000

Stop point:
Global linkage:

1000.000
Linked

Repeat: Cydic
Repeat count: 2
Pre-start state: Low
Pre-start delay: 0.000
End state:
Output type:
Pause type:

Pre-start state
High-Z
Last state

Signal Generator Settings

Type: Const. voltage

u: |3.301

Tolerance: £7 mv

- type of waveform;

- voltage level;

®) Auto  Min: | 0.000 Max: | 0.010
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Figure 6-30. Sine

Options

General

Generator:

TP10 (PIN1D) - Sine

Shown period:
Start point:
Stop point:
Global linkage:

Auto
0.000
1000.000
Linked

Repeat:

Repeat count:
Pre-start state:
Pre-start delay:
End state:
Output type:
Pause type:

Cydic

2

Low

0.000
Pre-start state
High-Z

Last state

Signal Generator Settings

Type: Sine

Phase:

Custom
phase:

Amplitude:
Zero offset:
Period:

o]
0.00 rad
2751

2.751

Freguency: 0.50Hz

AR[4p|4)

Data:

Tolerance: £7 mV

Minz | 0.000 Max: | 0.010

Sine settings:

Repeat: One shot/Cyclic/Custom - repeat option

Phase: Custom/0/Pi:2/Pi/3Pi:2 -¢0

Custom phase: - show phase in a radian

Amplitude: - amplitude

Zero offset: - zero offset

Period: - period

Frequency: - shows frequency

Data: - change signal using Custom Signal Wizard
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9

Options

Figure 6-31. Trapezoid (Triangle, Sawtooth)

General

Generator:

TP10 (PIN10) - Trapeze (Triangh ~

150.00

Shown period:
Start point:
Stop point:
Global linkage:

Auto
0.000
1000.000
Linked

Repeat:
Repeat count:
Pre-start state:
Pre-start delay:
End state:
Output type:

Pause type:

Cydic

o

Low

0.000
Pre-start state
High-Z

Last state

Signal Generator Settings

Trapeze (Triangle, Saw)

Mode: Normal

Umax: 5.501

(JIE]

Umin: 0.000

T low: 250.000
T rising:
T high:

T falling:

250,000
250.000

AR [4r|[4r|[4p»

250,000

Tolerance: £7 mV

Trapeze Settings:

9 Aute Min: |0.000 Max; | 0.010

Mode: Normal/Invert

-signal mode

Umax/Umin

-max/min voltage level

T1, T2, T3 T4

-duration of trapezoid

If T3 =1 signal is a triangle.
If T3=1,T2=2o0or T4 =2 signal is a saw.
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Figure 6-32. Duration of Trapezoid

Options
General

Generator: TP10 (PIN10) - Trapeze (Triangh

Shown period: Auto
Start point: 0.000
Stop point: 1000.000
Global linkage: Linked

Repeat: Cydlic
Repeat count: 2

Pre-start state: Low
Pre-start delay: 0.000

End state: Pre-start state
Output type: High-Z

Pause type: Last state

Signal Generator Settings

Trapeze (Triangle, Saw)

Normil

5.501

21K

0.000

T low: 250.000
T rising: 250,000
T high: 250.000
T falling: 250,000

AR|[AR][4F][4p

Tolerance: £7 mV

Auto Apply k= Apply Al Start Pause Stop ®) Auto Min: | 0.000 ms Max: | 0.010 ms -@
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Figure 6-33. Logic pattern

Options
Pre-start delay: 0.000
End state: Pre-start state
Qutput type: High-Z
Pause type: Last state

Signal Generator Settings

Type: Logic pattern

Mode: Normal

Levels
adjustment:
Umax: 4.501

Standard

Umin: 1.455
Pattern: 101101010111

T
500,000
500,000

ms

ms

ms

500,000
500,000
10 500,000
11 500,000

500.000

ms

5
6
7 | 500.000
8
9

ms

ms

ms

AR |0 [ [ (A [0 [ 4

ms

Insert before row | 1

Remove row 1

Levels count: 12

Data:

Tolerance: £7 mV

Auto Apply

Configuration options:
Mode:
Levels adjustment:

Umax/min:
Pattern:
Repeat:
T/Level:
Insert:
Remove:
Count:

@ Auto  Min: | 0.000 Max: | 0.010

Normal/Invert
Standard/Custom

0 — low/ 1- high level
One shot/Cyclic/Custom

- signal mode

- sets standard Umax/min for all levels or
U for each level

- Umax/min for all levels

- pattern of pulse levels

- repeat option

- sets duration of level

- insert pulse before selected position;

- remove pulse from the selected position;
- pulse count
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Figure 6-34. Custom Signal (Arbitrary waveform)

Options
General

Generator: TP12 (PIN12) - User defined

Shown period: Auto
Start point: 0.000
Stop point: 1000.000
Global linkage: Linked

Repeat: Cydic
Repeat count: 2

Pre-start state: Low
Pre-start delay: 0.000

End state: Pre-start state
Output type: High-Z

Pause type: Last state

Signal

Type: Custom signal

Set Signal

Tolerance: +7 mV

®) Auto  Min: | 0.000 0.010

Custom Signal Settings:

Repeat: One shot/Cyclic/Custom - repeat option;
Data: Set Signal - change signal using Custom Signal Wizard
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6.2.6. Custom Signal Wizard

Figure 6-35. Drawing Signal (Arbitrary waveform)

L3 v —_—
Clear A Add Point Add Peak Continuous Ramp ‘r Remove Point Data panel ' Import points Lock X LockY Clase

Data
X Value ¥ Value
0.00 ms 42471 mvV

86,29 ms 4263.9 mV
170.90 ms 3745.5 mv
221,66 ms 27757 mV
255,50 ms 1220.6 mV
307.95 ms 852.8 mV

370,56 ms 1973.1 mv
429,78 ms 4330.7 mV
459,15 ms 44930 mv
578.68 ms 4447.8 mV
627.75 ms 4314.0 mV
681,90 ms 4180.3 mv
730,96 ms 4096.7 mV
791,88 ms 3745.5 mV

839.26 ms 28429 my

o || ol ||| o | ol || ol | o o || ol | || o | || |

L L L S L L LS S S L

1488.2 mV

Min T: 2.96 ms T: | 1000.00 ms + | Max T: 363104.85 ms Available points: 45 -@

Toolbar: Clear - clear data
Add Point/Add Peak/Continuous - draw mode

Ramp/Remove Point

Data panel - turn on/off the data table

Import points - copy points from another
application

Lock X/Y - lock point position for X or Y
axes

Close - close window with current
signal
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Figure 6-36. Peak

x —
Clear A Add Point JLAdd Peak f [Continuuus Ramp “r Remove Point Zi Data panel 7 Import points Lock X LockY Close

Data

27 | B71.40 ms 2942.9 mV -

23 | 930.63 ms ~ | 0.0mV

Min T: 1000.00 ms T:  1000.00 ms Max T: 258717.57 ms Available points: 32 @

X Value ¥ Value 5

11 [ 409.38 ms ~[oomv =
12 | 409.48 ms =) 26754 mv | || =
13 | 450.08 ms < | 0omv sl =
14 | 490.59 ms +|0omv Sl =
15 | 490,69 ms =] 25918 mv =
16 | 526.23 ms ~|33.4mv | || =
17 | 603.96 ms < | oomv Sl =
18 | 604.06 ms = 2575.0 mv | || =
19 | 639,59 ms = 0.0 mv S| d| =
20 | 707.18 ms ~ | 0.0 mv - | =
21 | 707.28 ms < | 2708.8 mv | | =
22 | 763.11ms <167 my | | =
23 | 82224 ms + | 0omv Sl =
24 | 82234 ms = | 20429 mv ~| | =
25 | 835.87 ms ~ | 0.0 mv S| =
26 | 871.30 ms ~ | 0.0mv sl =

dp

L

& |[ =

29 0.0 mv

Figure 6-37. Continuous Ramp

= 7 —
Clear A Add Point Add Peak Continuous Ramp x Remove Point Data panel ' Import points Lock X LockY Close

Data
X Value ¥ Value
ms 0.0 my

87.99 ms 25583 mV
174.28 ms 31101 mv
187,82 ms = | 31937 mv
336.72 ms 34111 mv
434,36 ms 33442 mv
497.46 ms 32606 mV
£12.52 ms 3511 mv

681,90 ms v | 668.8 mv

722,50 ms 1003.3 mv
74619 ms 1203.8 mv
793.57 ms 18895 mv
317.26 ms 28760 mV
837.56 ms 42471 mV
888,32 ms 46150 mV
956.01 ms 45314 mV
959,39 ms 34111 mv

976.31 ms 1683.8 mv

Min T: 29.55 ms T: | 1000.00 ms | MaxT:322759.87 ms Available points: 42 @

o | ol | o (| o || o || || | ||| | o | | ] R

0.0 my.
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Remove Point: Removes selected point. Double-clicking on the point will also remove it.
Data panel: Turns on/off the data table. User can remove/change values for selected point or add new point
between two existing points.

Figure 6-38. Import Points

Insert points here

50,7

100.4
210.8
300.0
4051

Options

Decimal separator Column separator Row separator

point = tab ["t) = auto (line feed) =

[ | Test oK

User can insert points from another application and set separators options:
Decimal separator: point/comma;

Column separator: auto/tab(“\t”)/other;

Row separator: auto(line feed)/ tab(“\t”)/other;

Figure 6-39. Data Panel

Min T: 0.20 ms [ T: | 1000.00 ms - [ Max T: 39321000 ms Awvailable points: 59 -@

Period / cursor /
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Figure 6-40. Cursor

Clear A Add Point j\,Add Peak [ [Contlnuous Ramp

x =) =
_",‘r Remove Point Data panel I Import points Lock X LockY Close

Data
¥ Value ¥ Value -

1 | 0.00 ms 0.0 mv = | =
2 | 55.84ms ¥ | 3779.0 mv vi®|=
3 [121.83 ms ¥ | 38458 mv vi®|=
4 12650 ms v | 41635 mv =]
5 | 13367 ms + | 4696.6 mv =]
6 | 196.28 ms < | #197.0mv || =
7 | 197.97 ms ~ | 4498.0 mv || =
8 | 214.839 ms +| 45481 mv vl | =
9 | 262.27 ms < | 33TTEmv vl | =
10 | 282.57 ms +| 33442 mv =
11 | 362.10 ms +| 44812 mv =
12 | 546.53 ms > | 32040 mv | =
13 | 626.06 ms + | 3862.6 mV | =
14 | 649.75 ms ¥ | 28259 mv vi®|=
15 | 638.66 ms ¥ 327 mv vi®|=
16 | 708.97 ms + | 43809 mv =]
17 | 742,81 ms ¥ | 4063.2 mv =]

Min T: 59,10 ms T:[100000ms % || MaxT:322759.87ms | Available points: 38 | ~@) 18 | 808,80 ms vjasetamy o) &=
19 | 874.79 ms =l 4297.3 mv =il g || =]~

6.2.7. VDD/VDD2 Power Signal Generator

Figure 6-41. VDD/VDD2 Power Signal Generator

Simple signal generator for VDD/VDD2 with its own options.

The additional power supply (VDD2) on some chip revisions provides the ability to interface two independent
voltage domains within the same design. Users can configure pins, dedicated to each power supply, as inputs,
outputs, or both (controlled dynamically by internal logic) to both VDD and VDD2 voltage domains. Using the
available macro-cells designers can implement mixed-signal functions bridging both domains or simply pass
through level-translation in both HIGH to LOW and LOW to HIGH directions.

Sync Power Rails [S] mode means that VDD and VDD2 will share the same power settings. VDD2 will have the
same power options as VDD. Sync power options is available only for VDD/VDD2 power generators.
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6.3. Expansion Connector
User can connect/disconnect I/O pads of GreenPAK with the expansion connector on the board.

Figure 6-42. Expansion Connector

2|4|6 |8 |w|i2|14]|16]|18|20|vb|22|24|26 |28 |30 |32
Va|3 |5 |7 |9 |G |13]|15]17 |19 211232527 |29 |31

Int. VDD || Ext. VDD ON || OFF TP Map
LEDs ON | | LEDs OFF

6.4. Control panel

Figure 6-43. Debugging controls

Change platform

GreenPAK Pro
Development Platform

Import configuration

Device: | Onboard 12C Reset

Read
Emulation - Test Mode Program -

Project Data

Start All Pause Al Stop All

2|4|6 |8 |10|12|14]|16]18 |20 |vb|22|24|26 |23 |30 |32
Va|3|5|7 |2 |G|13|15)17]|12 2112312512729 )31

Int. VDD | | Ext. VDD ON | | OFF TP Map

LEDs ON | | LEDs OFF

PIN: SLGA6826V/G (0x1), DB HW-FW: 1.0.3-2.4

Change platform:

Select type of hardware platform with supported features

Import configuration:

Allows user import configuration of test points from another platforms.

Device:

Allows user work with external chip on specified device address

12C Reset:

If I2C serial communication is established with the device, it is possible to reset the device to initial power up
conditions, including configuration of all macrocells, and all connections provided by the Connection Matrix. This
is implemented by setting register 12C reset bit to “1”, which causes the device to re-enable the Power-On Reset
(POR) sequence, including the reload of all register data from NVM.
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Emulation:
® Emulation - the current project will be loaded to the chip (but not programmed), and will be ready for test
on the hardware board.
* Emulation (sync) — in addition to Emulation, each change that is made in the project, will be immediately
loaded to the chip.

In the case when Int. VDD and VDD key on the Expansion connector are turned off, a warning message will pop
up (Figure 6-44).

Figure 6-44. Incorrect Power Configuration

L Incorrect power configuration

Mo power source is connected to the chip.
l b The internal power source will be connected automatically.

oK. Cancel

Test mode:

Test mode is used for connecting or disconnecting the chip’s I/O pads to TP controls, configured by user.

Also, a user can check the programmed chip using the test mode without emulation. In order to do this: turn on
the test mode and internal VDD button. The test mode can work without power on the chip. User will control the
power manually.

Read:

Read chip using hardware board.

Program:

Program chip with the current project. For some chip models user can configure programming process by clicking
Programming options at Program button. Choose programming options:

® Program NVM - programs chip NVM,;

® Program EEPROM - programs chip EEPROM,;

Project Data:

The table of NVM and EEPROM(optionally for some chip) bits.

Pattern ID — gives an ID (1-255) to the project. The ID will be put in the chip after programming, and also will be
read back while in “chip reading” operation.

Lock status — blocks NVM reading/writing. A programmed project becomes unavailable for chip reading/writing.
Use current project’s sequence for Programming and Emulation process — user can choose to use current
project's sequence for programing and emulation process.

Use this sequence for Programming and Emulation process — user can choose current sequence for
programming and emulation process.

Reload from current project — user can load bit sequence from current project.

Clear — sets all bits to false.

Export — save data to text file.

Import — load data from text file.

Open in new Designer's window — open current bit sequence in new Designer’s window.

Dialog Semiconductor www.dialog-semiconductor.com
12/19/2019 71



¢dialog

SEMICONDUCTOR GreenPAK Designer 6.21

Figure 6-45. Project Data

Loaded file: Current project
MYM EEPROM
R W Index Value Comment = | Export |
o g | | import |
1o |
z | 0 |
3| o |
4 | 0 |
5 0 |
6 | 0 |
70 |
g | 0 |
9 | 0 |
10 | 0 |
1| 0 |
-
Lock status: | Unlocked - | ' Use current project's sequence for Programming and Emulation process
PatternID: |1 |‘| () Use this sequence for Programming and Emulation process
| Reload from current project | | Clear | | Open in new Designer's window | | Close |

In GreenPAK Designer for chips with 12C Serial Communication new columns describes register flags in 12C tools
and NVM Data window:
- 12C Legend:

®* Green — Supported;
® Red - Not supported;

® Yellow - Partly supported (operation is supported for some part of data block);

- 12C Operations:
® R-12C Read;

® W-12C Write;
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Figure 6-46. 12C operations in NVM Data window

Loaded file: Current project Pattern ID: Lock bank 0, 1, 2 WM (read)
R | W Index Value Comment =
1842 false
1843 false
1844 false
1845 false
1846 false
1847 false
R false
R false
R false
L RE false
I e false
L RES false
RN false L
L RE false
I 1856 false =
I 1esT false L
B oo e .74
[ Reload from current project ][ I Impart |[ Open in new Designer's window |
(@ Use current project’s sequence for Programming and Emulation process
() Use this sequence for Programming and Emulation process

Chip Details:
Show details about chip and board

Log:
Show log.
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Test points configuration:

- Save current configuration of a test points to the project file
- Delete selected configuration

- Import new configurations from project files or platforms

Figure 6-47. Test Points Configuration

Default
Configuration 1

Configuration 3 (H] (3 |[/ma Import

Support for multiple devices:
This feature allows user to connect few supported hardware boards and select specific one for performing the
operations.

Figure 6-48. Multiple hardware devices
GreenPAK Advanced Development Board [ID: 0x20b] In use Blink e
GreenPAK Advanced Development Board [ID: Ox203]

Blink:

Selected board blinks to notify its selection

Refresh button:

Refresh button updates chip information in bottom right corner of the Debug tool.

Socket Test:

This feature allows testing the socket connectors to ensure that it works properly and doesn't have influence on
emulation or reading/programming processes.

Figure 6-49. Socket Test Results

—
'Q:' Functional socket test falled. Socket issues detected,
| show Detais... || ok
TP ID Low Measurement State High Measurement State |+
T VoD - VoD -
TP2 -2.64 mv 0K 5070.00 mv 0K
TP3 -1.44 mV oK 5079.00 mV oK
TP4 -3.54 mV oK 5079.00 mV oK
TP =144 mv oK 5078.70 mV oK
TPE -6.24 mV oK 5079.00 mV oK
TP? -2.%4 mV oK 5079.00 mV oK
TP8 -2.54 mvV oK Low level test only
TPS -3.24mv oK Low level test only -
P10 -3.54 mV oK 5079.00 mV oK
P11 GHND - GND -
P12 -2.04 mV oK 251.70 mV Fail
P13 510 mV oK 2283.00 mV Fail [
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12C Tools
Start Debug to start work with 12C tools:

Figure 6-50. I12C Tools in Debug tool

&} Add Signal generator * @ AddProbe * 3§ Remove VI I2C Virtual Inputs | I2C Virtual Qutputs | 12C Reconﬁguramrl

The 12C Serial Communication Block (I12C) in the chip allows an 12C bus Master to read and write information via
a serial channel directly to the RAM registers. This allows the remote re-configuration of macro-cells. The user
has the flexibility to read and write registers not associated with NVM memory. Those registers are the signal
outputs of macro-cells in the device, giving the 12C bus Master the capability to remotely read the current value of
any macro-cell. Up to 16 GreenPAK I2C slave devices can share the same serial bus. You can choose any
external device address and work with external chip using Device selector in Debug tool: Onboard or any of 16
GreenPAK 12C slave devices:

Read
Emulation Test Mode
Program

I Device: I MVM Data

Pause Al Stop Al

2|46 |8 |10)12]14|16|18|20|vb|22|24 |26 |28 |30|32
Va|3|5]|7]9% |G |13]15]|17]|19 21]23 25|27 | 29|31

Int. VDD | | Ext. VDD ON || OFF TP Map

Chip P/N: Unsupported SLG46538V/M {rev. XB)
Board HW/FW rev.: 1.3.1/2.7

The 12C cell also has dedicated registers (12C Virtual Output bits) as well as dedicated arrays in memory (RAM
Array Table) only accessible through 12C. The 12C Virtual Outputs are also signals that enter the matrix. To start
12C Tools Emulation or Test Mode is required.

12C Tools has 3 separate windows:

12C Virtual Inputs:

- 2
| 12C Virtual Inputs b
Choose the component: Log

Registers - 0xEB 0x73 E
OxES 0x01
B Current val Newval OxEA 0x01
€, . urrent value, ew value, - OxEB 0x01
R oW S Registers e e e Fos
39 [463:456] 0] w00 Writ OxED Ox01
OxEE 0x01
03A | [471:464] 0x00 000 OxEF 0x00
036 | [479:472) 0x00 000 00 0x00
01 0x00
03C | [487:480] 0x00 000 oxF2 0x00
03D | [495:488] 0x00 %00 OxF3 0x00
04 0x00
B3E | [503:456] 0x00 00 0%F5 x01
. 0xF6 0x04
O3F | [511:504] 0x00 00 paiad o
00 | [519:512) 0x00 w00 0xF8 Ox9F
. 0xF9 0x92
o1 | [527:520] 0x00 000 el o
o2 | [535:528] 0x00 000 0xF8 0x5A
OxFC OxIE
03 | [543:536] 0x00 000 pols o1
o4 | [551:544] 0x00 00 Vit OuFE 0x00

ovas | [55a.557] von o A O DxAS b

Read Write Clear

® Counters/Delays — the counter/delay data in the device can be read and write via 12C;
® [2C Virtual Inputs — the 12C Virtual Inputs OUTO0-OUT7 value in the device can be read and write via 12C;
® Registers — the current value of all device registers can be read and write via 12C;

®* Log - shows log of read/write operations.
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12C Virtual Outputs:

[SLGA6824V] - GreenPAKS Designer v.6.15 - a
Fle Edt View Toos Options Help
. . N = ~ oo
et D A oy
B= o. F ¥ B & & B A W =
MNew Open Save Print Undo Redo SetWire | Erase Wire Setlabel Erase Label Rules Checker | Debug Project Settings ~ Project Info Properties | Components | NVM Viewer
A" Rotateleft I Rotate Right Flip Horizontal Fipvertical | U] Algn Horizontal |- Align Vertical @ Add Signal generator v @ AddProbe v ¥ Remove ¥ 12C Virtual Inputs | L2 Virtual Outpuis | L2C Reconfigurator

12C Virtual Qutputs a®
12C Virtual Outputs.

Refiesh Last Update: 18:27: 18

Macrocell Property Value
16-bit CNTO/DLYO/FSMO (MFO) CountedData 39573
8-bit CNT2/DLY2 (MF2) Counted Data s
8-bit CNTA/DLYA (MF4) Counted Data s

-G -

Debugging controls | 12C Virtual Outputs

Components List ®

Components
~ 1opADs -

! VDD (PIN 1)

V| P2 100)

v PIN3(01)

v PIN4(02)

Y PIN5(103)

v PING (109

v/ 7 105)

v PINB(SCL)

V| PINS (sDA)

V| PIN 10 (106)

V| GND (PIN 11)

V| PIN 16 (1010)
v PIN 17(011)
7 PIN 18 (012)
v PIN 130013)
7 PIN 20 (1014)

~ Analog Comparators

A CvPOL

AcwL M
- e "RNEYES « ||| pefaut pl=]1:] L] G Advanced Developme Bink @ || |[ show all | Hdeall

® Probes (Matrix inputs) — the current level on blocks output pins in the device can be read via 12C. User
can add probes to any pin(or to all visible pins) or remove probe(or all probes);

® Counted Data — the current count value in some counters (see Datasheet for selected chip revision) in the
device can be read via I12C.

12C Reconfigurator
Figure 6-51. 12C Reconfigurator
12C Reconfigurator [ = |

+GRIA Y =[5

L L
On Mame Value
o Snapshot @17:27:31 Load ]Overwrib&
® Delay 100 ms

® Spapshot @17:27:37
®' Snapshot @17:27:40
® Delay 10000 ms

Log

I12C Reconfigurator allows user to change data dynamically on chip by sending NVM snapshots into chip.
Snapshot of the NVM sequence saves configuration of macrocells and connections between macrocells. The user
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can configure list of snapshots and send into the chip in two ways: send one by one or send all. Also delays
between snapshots can be added.

Snapshot configuration:

$ G A v = 5

>

On Mame Value
O snapshot @17:27:31
L)
L)
L)
L)

Delay 100 ms
Snapshot @17:27:37
Snapshot @17:27:40
Delay 10000 ms

Ilog

® Snapshot — button adds snapshot of workarea to the list;
® Delay — button adds delay between snapshots to the list;
®* Up — moves selected list item up one level,

® Down — moves selected list item down one level;

®* Remove — removes selected list item;

® Reconfiguration scenario — shows main snapshot and it changes.
Also snapshot has value:

® Load - loads snapshot data to the project;

® Overwrite — overwrites snapshot with project data;
Snapshot operation:

On Mame Value I

> Delay 100 ms
®) Snapshot @17:27:37
®) Snapshot @17:27:40

O Ssnapshot @17:27:31
L)
L)
L)
L)

: Delay 10000 ms

Log

® Send one — send one snapshot to the chip;
® Send all — send all snapshots from the list to the chip;

® Stop - stops sending snapshots.
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External chip

DIP/Advanced/Pro platforms
To start work with external chip for DIP, Advanced and PRO platforms:
1. Connect socket with External chip to Development Board via pins:

® Corresponding I12C pins (SCL, SDA);
* VDD pin;
®* GND pin;
For DIP/Advanced Development board: connect socket with External chip to Expansion connectors pins:

DIP Expansion connectors:
ey .‘ - L:;:H_j- o 1 el el NN &)

Expansion
connectors

Expansion connectors

For PRO Development board: connect socket with External chip to external port on GreenPAK PRO Development
Board (right connector):
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Expansion connectors
Disconnect Onboard chip to proceed with the External chip (For DIP/Advanced/Pro platfroms)
Start GreenPAK Designer and select revision of connected External chip
Start Debug tool and select Development platform
Select Device address as 0001b (used by default for empty chip) or corresponding address programmed
to the chip.

ok owwn

Attention: if external socket properly connected to development board and proper Device address selected - chip
detects after clicking Update chip info button or automatically after starting any chip operation:

GreenPAK Pro chae platfam
Development Platform

Import configuration

Device: | External: 0001 ~ 12C Reset

Read
Emulation - Test Mode Program -

Project Data
Start All Pause Al Stop Al

2|4]|6|8 |10]|12|14]|16]|18]|20 |Vb|22]|24 |25 |28 |30 |32

va|3|5|7]a|c |13]15]|17]19 21|23 25 |27 |29 | 32
Int, VDD | | Ext. vDD on || oFF TP Map
LEDs ON | | LEDs OFF
P SLG468240/G (0x1), DB HW-FW: 1.0.3-2.4 | 0=

6. Now user can use all Debugging chip controls: Emulation/Test mode/Read/Program for external chip
Attention: Ext. VDD (Va) expansion should not be enabled if exist voltage on external VDD port. It automatically
disconnects while starting Emulation/Test mode operations for chip with existing external voltage with warning
message.
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In-System Programmer
To start work with external chip on In-System Programmer platform:
1. Connect chip with wires to In-System Programmer pins (VDD, CLK, SDA, GND):

2. Start GreenPAK Designer and select revision of connected External chip

3. Start Debug tool and select In-System Programmer platform

4. Select Device address as 0001b (used by default for empty chip) or corresponding address programmed
to the chip or select

5. Specify VDD configuration: Internal (chip will be powered from ISP board) or External (chip should be
powered from external power source)

6. Now user can use all Debugging chip controls: Emulation/Test mode/Read/Program on In-System
Programmer platform
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7. Asynchronous State Machine (ASM)

7.1 ASM block

The ASM block is an 8-state asynchronous state machine. There are 24 state transition inputs, one nRESET
input, and 8 output lines. The ASM block is defined using state transitions and state outputs.

Figure 7-1. ASM block.

AS|
(State 0)

ASM OUTPUT

oob00000

Transitions

The state machine is constructed by defining the one-way connections between two states gated by a transition
control input. The state machine will transition to another state any time these two conditions are met: the current
state has a transition connection to another state, and that transition enable signal is HIGH. The transition enable
signals are controlled by the 24 inputs, and there are 3 transition enable signals per state.

Outputs

The ASM block has 8 outputs to the connection matrix. You can define the output of the 8 outputs based on the
current state. This is done in the properties tab by double clicking the desired output for a given state and output
line to invert its output.

Editing the ASM block

The ASM block can be defined through either the properties panel on the left, or the ASM editor. The ASM editor
is a graphical interface for defining the ASM and editing labels. Double-click on any ASM component to open ASM
Editor.

In the properties tab, you can select a state, edit its name, and configure all of its transition enable switches. Also,
you can define the ASM Outputs, edit the label names for each output, and set the Initial/reset state. In the context
menu of ASM block you can split ASM block to separate states blocks and to separate transitions (figure 7-2).
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Figure 7-2. Split ASM block to States/Transitions.

¢ State 0 -> State 3
o State 0 -» State 7
o State 0 -» State 2

Initial/reset state

The ASM block will power up to the state defined as the Initial/reset state. It is by default State 0, but can be
changed to any state. It also defines which state the ASM will be reset to. When the logic on nRESET is LOW, the
ASM will be kept at the Reset state until the logic at nNRESET goes HIGH.

7.2. ASM Editor

ASM editor(figure 7-3) allows to configure the ASM block using state diagram and set the output configuration for
ASM Output block ASM configuration should be applied using Apply button on the toolbar to be set to the NVM.

States
State colors:

® Green: regular state;
® Blue: selected state;
® Red: initial (reset) state;

® Gray: state connections limit reached;

Move
State can be moved by dragging it's central part using left mouse button. Dragging the border circle will have no
effect.

Context menu
® Edit name: set state’s name;

® |nitial state: sets current state as initial;

® Hide: hides current state.

Transitions
Add/remove links

® To create new link turn on 'Set Link’ mode and click on the border circle of source state, then click
anywhere on state-destination or 'Esc’ to cancel;

® To erase link - turn on 'Erase Link’ mode and click on the link which should be erased.

Edit shape
Link’s shape sets automatically after states change their position. Modifying of the existing shape is available in
two ways:

* Simple edit: one-point editing by dragging the link;
* Flexible edit: two-points editing by entering in 'Edit path’ mode using link’s context menu;
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Context menu
® Set Label: sets the text label onto link;

® Erase Label: removes the text label;
* Edit path: flexible two-point editing of link’s shape.

Figure 7-1. ASM Editor.

File Edit View Help

™ & ¥ © B N

= = E = = —

= Clear Apply  Revert 5 Prmt 5 auto Route Setlink | Erase Link Setlabel FErase Label | Properties || RAM Array
[a]

Properties [E5)

* —

State name: START

e - o = nopoooo-o
= aannoon
D suee [« [0 [ [ o [o|o]o]

Initial/reset
state:

evsomo &%= Ene EIE]E]@E]@E]E]
s = n-poonnno
wr [afofofofofofo]o]

Bulk operations

All to 0 2] [ set |

States

State 0 (START)
State 1 (PROCESS)
State 2

State 3

State 4

State 5 (END)
State 6

State 7 (WAIT)

(show al | e al |
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8. GreenPAK Simulation
Simulation Panel in GreenPAK Designer:

File Edit View Tools Options Help

H=0.0. F ¥ © % ® B £ B2 N w® =

MNew Open Save Print Undo Redo SetWire | Erase Wire Setlabel Erase Label Rules Checker Debug Project Settings Project Info Properties | Components | NVM Viewer

A% Rotate Left [\ Rotate Right Flip Horizontal Flip Vertical | Align Horizontal l Align Vertical I @ Add Voltage Source v @) Add Probe v 3§ Remove vI

Software Simulation

The Software Simulation Mode enables electronic circuit simulation, which uses mathematical models to replicate
the behavior of chip components included in GreenPAK. To start Software Simulation click on Debug button and
select Software Simulation in Development Platform Selector. Before starting the analysis, use other simulation
tool buttons to configure the simulation environment parameters as shown on Figure 8-1.

Figure 8-1. Basic Simulation Tools

Ground

Probe

//'
//,/'

Voltage Source

Add Probe Button

Adds probes to block outputs which shows simulation results graphs over time. Probes are used to capture the
output signal from specific node. Probes can be added to the output from any pins, as well as the outputs for any
internal resource.

Add Voltage Source Button

Adds configurable voltage source or ground to external I/O pin on chip. Voltage source added to VDD pin by
default. Voltage sources cannot be added to any internal resource. Voltage source can be configured by double
mouse click on it or through context menu as on Figure 8-2.

Remove Button
Removes voltage source or probe by mouse click on it or all probes or sources from context menu.
Simulation pins configuration:

- Save current configuration of pins to the project file
- Delete selected configuration
- Import new configurations from project files of the same chip revision

Default

Configuration 1

Configuration 2

Configuration 3
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Figure 8-2. Voltage Source Setup Window

Options
General

Voltage source: PIM 2 (Src) 2.00 ......... : LU eefeden feeeedieeaden 2.00

Name: PIM 2 (Src) _ I # _
FT | lobhosochor ocnfiosodiososiiacosaacofbosady, “wofnmoooninoosjaoacda o eofemsodioacogpn | 150

Pre-start delay: 0,000
100 [ i b b b M e B b d e e 1.00
Show only one
period I
0.50 SRS RS- SN UL SR U SRR U SO "S- R SR SUUON SR SO 0.50
Limit voltage to !
VDD level | |
0.00  fdoe bbb e b e e PP ST S | o.00
Customize source

Internal capacitor: = 10.000

Internal resistance:™ | 10.000

2.50 O PP UOE N FOPIN RO S0 /ISTNN IO USNE SEN SO FUSE SOST: WO SO

Copy from:

I e NS NN NN PN v 0 OV NN VSR NS AP S ST O

Violtage Source Settings a 1.50 B g e RS -

Type: | Sine Lol

0.50 0.50
Zero offset: 1.000 1

0.00 |+ : } 0.00
Amplitude = 1.000
Frequency: 1000.000 5.00 1 o fbenontascbenes iooahaonn st bare A - U SN SO SO SO 5.00
Damping factor: | 0.000 4.00 bbb bbb bbb bbb d e 4,00
R CQ oo oosojonoiocofouOs RO T S S T SO SO S I o 3.00
700 [K I N S SRS N S et 2.00

1.00 1.00

{ms)

General
Voltage source Source selector
Name Customizable source name
Pre-start delay Delay before start
Show only one period Shows one period of voltage source

Customize source:

Internal capamtor This parameter defines value of the capacitance between voltage source
terminal and ground. It can be used to model VDD bypass capacitor or IC pin
parasitic capacitance.
R C
vV — —
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Internal resistance This parameter defines the output resistance of the generator. Mon-ideal
(real) voltage source is modeled with two components: ideal voltage source
and resistance connected in series.

-
||
1

Copy from Copy parameters from any voltage source

Voltage source settings

Type DC, Trapeze, Sine, Exponential, - type of waveform
Custom signal, Logic pattern, Clock
generator

Please see for the reference the voltage source settings in Emulation tool (Chapter 8, 10)

Simulation Debugging controls

Transient Analysis settings in Debugging controls window define period of time for simulation, maximum time
step, source voltage and temperature (Figure 8-3). Note: If there is a change in the state of any probes, there will
be a step generated at that time, the “Maximum time step” variable will only insure that if no probe data changes
for this period, another step will be generated.

Figure 8-3. Transient Analysis Window

‘! Software Simulation Change platform

Transient analysis settings:

Ending time:
Maximum time step:
VDD
Temperature (5C):
Use initial conditions

& Estimated completion time is less than 30 seconds

w Start simulation Show plots
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Transient analysis parameters:

Parameter Max time value Min time value
Ending time 1000s 0.0001ms
Maximum time step 20s 0.0001us

VDD 6V 0.001mV
Temperature (°C) -40 +85

Estimated completion time

Software estimates the run time in three broad categories: green, yellow and red, based on sample points. As a
general rule, green runs will complete quickly (less than 10 secs), yellow runs within one min, and red takes
longer. Run time also varies based on the speed of your computer so the estimated times vary widely. Longer run
times will also require greater resources on your computer, including CPU and memory resources.

Note that it is possible to define simulation runs that will exceed the available resources on your computer, which
can potentially make your computer unstable. This may be true any time the estimated run time is categorized as
“red”.

To start simulation, in transient analysis window set required parameters and click OK. After simulation
performed, user will see Simulation results (Figure 8-4).

Simulation Results Window

Figure 8-4. Simulation Results Window

Waveforms
[4] [S] PIN 3 (Srq)

(4] [5] VDD

[D] [F] 2-L0 -> OUT

[D] [F] PIN 3 -> OUT

12.0ms Show Configure

' &

M (5] PIN 3 (5}

uy
<

DD
PIN 3 (Sr()
F] 2-10 -> OUT
[F] PIN 3 > OUT
[FIPIN 3 > OUT 2)
Group (5)

10.0ms ns Remove
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IMPORTANT: The simulation result window has 3 section:
1. Plot Widget: displays the waveforms;
2. Waveforms: contains a list of all captured signals (probes) and source generators;
3. Groups: contains a list signals that currently are displayed on Plot widget.
a. User adds the signal from Waveforms section to the Groups to display it.

b. It calls ‘Groups’, because each waveform after adding to the Group section becomes a group of 1
waveform. User can select multiple waveforms at the same time and add them as a new
group (Figure 8-5).

Figure 8-5. Simulation Results Window Detail

[A] [S] PIN 3 (Srg)

4.0ms 6.0ms

Configure

Group (4]

4.0ms 6.0ms 10.0 ms 12.0ms
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In the Plot Widget, the user has following controls:

Action Hotkey
Pan mode Press middle mouse button
Marker A Ctrl + LMB
Marker B Ctrl + RMB

Clear all markers

Esc or context menu — Clear markers

Zoom in/out X

Ctrl + mouse wheel

Zoom in/fout Y

Shift + mouse wheel

Reset scales

Context menu — Reset scales

Markers and dt and dV parameters on plot widget showed in Figure 8-6 below:

Figure 8-6. Markers on Plot Widget

M [S] PIN 3

Dialog Semiconductor

12/19/2019

89

www.dialog-semiconductor.com



¢dialog

SEMICONDUCTOR GreenPAK Designer 6.21

In Waveforms window user can configure waveform and waveform base points parameters (style, color,
width/size):

Figure 8-7. Waveform Plot Configuration Window

Waveform

Style: | Lines
Color: | Custom [ff44ed63]

Width: | 2

¥ | Points

Style: | XCross

Color: | aliceblue

4

In Groups window user has the option to:
« Remove waveforms from plot widget;
* Organize order of waveforms;

* Show waveforms or group several analog waveforms from Waveforms list.
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9. Designing Overview

9.1. SLG4672x Properties Interpretation

Pin2

S0 Floating
S1

o o Res_sel[1:0]
@@ 00: floating
01: 10 kQ
10: 100 kQ
11:1 MQ
wosmt_en Non-Schmitt
PAD Trigger Input
:)nop %‘Mﬁ? [H']t]h t Schmitt Tri t 1 omten SChrqurtigger
- Digital In without Schmitt Trigger, wosmt_en= npu —
01° Digital In with Schmitt Trigger, smt_en=1 /3 !h- Digital In >
10: Low Voltage Digital In mode, Iv_en =1
11: analog 10 mode
Iv_en Low Voltage
Input
= Analog IO
Dialog Semiconductor www.dialog-semiconductor.com
91

12/19/2019



¢dialog

SEMICONDUCTOR GreenPAK Designer 6.21

Properties (=]
PIN 2
1/0 selection: | Digital Input ]
Input mode: T -
OF =0 [Dlgnﬁl in without 5c ]
Output mode: N -
OF = 1 one -
Resistor: [Pull Down = ]
Resistor value: I[ iM = ]
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Matrix OE 10 Structure (for Pins 3, 5,7, 9, 13, 14, 16, 18, 19)

Input Mode [1:0]

00: Digital In without Schmitt Trigger, wosmt_en—=1
01: Digital In with Schmitt Trigger, smt_en=1

10: Low Voltage Digital In mode, Iv_en =1

11: analog 10 mode

Output Mode [1:0]

00 1x push-pull mode, ppl1x_en=1

01: 2x push-pull mode, pp2x_en=1, pp1x_en=1

10: 1x NMOS open drain mode, od1x_en=1

11: 2x NMOS open drain mode, od2x_en=1, od1x_en=1

wosmt_en; Non-Schmitt
Trigger Input

pplx_en

S

smt_en Schmitt Triggen
}\ Input I p Digialln >

Iv_en , Low Voltage
Input

Only PINs 7,13,14,18,19
I Apalog |10

Digital Out

N
A OE
N odl1x_en

Floating

Res_sel[1:0]
00: floating
01 : 10 kQ

pp2x_en »———+

D o YR
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Properties [
PIN 3
N
1/0 selection: | Digital Input/Outou’ ~
Input mode: | pigital in without Sc % ]_I
g;t:';t TIiE 1x push pull =
Resistor: I[Pull Down = ]
Resistor value: [ 1M = ]
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Register OE 10 Structure (for Pins 4, 6, 8, 15, 17, 20)

Mode [2:0]
000 Dhgital In without Schmitt Trigger, wosmt_en=1, OE =0 .
001: Digital In with Schmitt Trigger, smt_en=1, OE = 0 wosmt_en, Non-Schmitt
010: Low Voltage Digital In mode, lv_en=1, OE=0 Trigger Input
011: analog 10 mode

100: push-pull mode, pp_en=1, OE =1

101- NMOS open drain mode, odn_en=1, OF =1
110: PMOS open drain mode, odp_en=1, OE =1 smt_en Schmitt Trigger|
111: analog 10 and NMOS open-drain mode, odn_en=1 and AlO_en=1 j Input > Digital In

Iven . Low Voltage
Input

—
Only PINs 6, 15

P _Analog 10

Digital Out » I
E Do }
2x_en \
pp_en / | = =

1

1
0

I~
90 k2 pull_up_en I
i

w@

Floating

Res_sel[1:0]
% 00: floating
01: 10 k
odp_en 10: 100 k&2
J:I>_F 111 M
Digital Out -
[oE> >c | I |
~— 2x_en
2x_en 1 L=
g \ L 1 odn_en
ppen/ |} = = j—C*
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Properties

PIN 4

1/0 selection: | Digital Output

Input mode: N

OE=0 ane
Output mode:

OF :1 1x push pull
Resistor: Pull Down

Resistor value: [ ™M
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Register OE IO Structure with Super Driver (for Pins 10, 12)

E\)ﬂ(‘%ieD[Z_U]I In without Schmitt Tri t 1

- Digital In without Schmitt Trigger, wosmt_en= -

001: Digital In with Schmitt Trigger, smt_en=1 wosmt_en;. Non-Schmitt
Trigger Input

010: Low Valtage Digital In mode, Iv_en =1
011: analog 10 mode
100: push-pull mode, pp_en=1

101: NMOS open drain mode, odn_en=1 L
110: PMOS open drain mode, odp_en=1 smt_en Schn’;ﬂtTr{gger
111 analog 10 and NMOS open-drain mode, odn_en=1 and AlO_en=1 17- npu P Digital In

Iven | Low Voltage
Input

P Analog IO

B
S

3l

st
S0
I

pull_up_en I
i

Floating

Res_sel[1:0]
] 00: floating
01: 10 kQ
odp_en 10- 100 kQ
j>f 1° 1 Mo
2x_en ,,_\ >_):D m
odn_en
pp en / | / — — N T—
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Properties 3]
PIN 10
1/ 0 selection:
é"E":tD"'“dE | Digital in without Sc % |
OQutput mode: i -
OE=1 - e
Resistor: Pull Down S
Resistor value: [ 1M = ]
Dialog Semiconductor www.dialog-semiconductor.com
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2-Bit LUT
reg <590:587>
From Connection
Matrix Output <70> i
—»{ INO To Connection
. Matrix Input <37>
N 2-bit LUT4 out—»=
From Connection
Matrix Output <71> >
IN1
Dialog Semiconductor www.dialog-semiconductor.com
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Properties 3]
2-bit LUT4

M3 IMZ2  IML MO ouT
o0 0 0
o [0 01
0o 10
0 0 |1 |10 =]
a 1 ] 0 |0 =
] 1 0 1 |0 =
] 1 1 0 |0 =
0 1 1 1 |0 >
1 0 0 0 |0 =
1 0 0 1 |0 =
1 0 1 0 |0 =
1 o | 1|1 [0 ™
1 1|0 | o [0 -
1 |10 |1 [0 -
1 1|1 | 0 [o :
1 111 (o :

Standard gates 2l to 0
[Deﬁned by user S ] All to 1

4 Detailed ,
= u'pplf
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3-Bit LUT

reg <606:599>

From Connection
Matrix Output <35i\

From Connectionr

Matrix Output <3}
From Connectio

Matrix Qutput <37>

INO

3-bit LUTO ourt

>IN1
(

N2

To Connection
Matrix Input <24>

_>

Dialog Semiconductor
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Properties

J-bit LUTD

INZ IN2  IN1 MO

o
[
=
]

1k

A e s === =]
R N = A =R R e R
AN A - =R =]

L

00 | 1 |0

—
L1

= | S
A4

,_.
1k

[UE T T T U T R
[ T e e =]

=

=

Ak

,_.
==
4p

Standard gates

Al to 0
[Deﬁned by user

All to 1

. Detailed .
— u'ppl-

L1
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2-Bit LUT or D Flip Flop Macrocells

IN1
From Connection Matrix Qutput <63>| .
2-bit LUTO our
" INO
To Connection Matrix
4-bits NVM Input <33>
——
reg <574:571>
LT
D
: . DFF4
From Cennection Matrix Output <62>
> ouT]
clk
1-bit NVM
reg <595>
Dialog Semiconductor www.dialog-semiconductor.com
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Properties [

2-bit LUTIVDFF/LATCH 4

] ] 0 |0 -
0 0 1 |0 =
] 1 1 |0 =
1 0 0 0 0 -
1 o o 1|0 &
1 i] 1 I =
1 0 1 1 |0 >
1 1 0 I -
1 1 0 1 |0 =
1 |11 0 |0 &
1 1 1 1 |0 =

Standard gates All to 0
[Deﬁned by user = ] all to 1

(7] ?nefzalled 3 ey

Properties

2-bit LUTMDFF/LATCH 4

Type: | oFF /LarcH 3
Mode: DFF =
nSET/nRESET . Y
option: ons hd
Initial [L . -
pﬂhritv: aw w
Q output . -
e [Nnnﬂnverted Q =
Dialog Semiconductor www.dialog-semiconductor.com
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3-Bit LUT or D Flip Flop with Set/Reset Macrocells

From Connection IN2
Matrix Output <43> > .
Nt 3-bit LUT2 our
INO
From Connection To Connection Matrix<
Matrix Output <42> ‘ -bits NV Input 26>
N -bits
-
reg <622:615>
D
M. et 41> DFF2
nRST/NSET
OUT]
clk
1-bit NVM
reg <671>
Dialog Semiconductor www.dialog-semiconductor.com
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Properties [

3-bit LUTZ/DFF/LATCH 2

Type: LuT S
N3 IM2  IM1  INO ouT

0o 00 o
o 0 0 1
o0 1 0
o 0 1 1
0 1 0 o
o1 0 1
o 11 0
0 111
1 0 0 0 0 -
1 oo 10 m
1 0 1 0 |0 =
1 0 1 1 |0 ¥
1 1 0 0 |0 -
1 1 0 1 |0 =
1 |11 0 o &
1 1 1 1 |0 =

Standard gates All to 0

[Deﬁned by user = ]

?.—.Ef? = =) Apply

Dialog Semiconductor www.dialog-semiconductor.com
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Properties

3-bit LUT2/DFF/ILATCH 2

R DFF / LATCH
Mode: DFF
nSET/nRESET

option: nRESET

Initial —

polarity: oW

Q output ——
polarity: Mon-nverted (Q)

Dialog Semiconductor www.dialog-semiconductor.com
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3-Bit LUT or Pipe Delay Macrocell

reg <670:663>

INO

TOM Connection >
MatnxOulput<60>h N 3-b|t LUTS ouT

From connecuon

To Connection
Matrix input <32>

Matrix Output <61=>
—m, IN2
Ireg <670.667= !
reg <964=
[]
]
(] 0 OUT1
o —
EEEEEEEEEE 1 To Connection
Matnix Input<41=
rom Connecton ——»| RST
Matrix Output <60=
> .
TR —— N 16 Flip flop Block
i X DUL < >
From Connection —+—p| CLK
Matrix Quiput <61=
EEEEEEEEEE
5 ouTo
: ol
To Connection
Matrix Input <40=
L1
reg <666:663=
ouT2
-
To Connection
Matrix Input <32>
Dialog Semiconductor www.dialog-semiconductor.com
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Properties

Type: |t hd
N3 INZ  IML IND out
0 0 0 0 D
0 0 0 1 B
0 i 1 0 E
0 0 1 1 D
0 1 0 0 D
0 1 0 1 B
0 1 1 0 E
0 1 1 1 D
1 0o | 0o | 0o -
o o 1 o v
1 0 | 1] 0 |0 -
]_ I:I ]. ]- U :
1 1| 0 | o [o ~
1 10| 1 |0 -
1 1 | 1] 0 |0 -
]. ]. ]. ]_ (] :
Properties
3-bit LUTS/Pipe Delay
Type: [Pipe Delay - ]
QUTO PD num:
OUT1 PD num:
‘;ﬂuai_l;:‘:tp“t ann—inuertEd (our: = I

3-bit LUT8/Pipe Delay

0 Detailed
W Info

-""F'F'I'r'

—_———————————3

X )
— ouTL

1PIPEOUT
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4-Bit LUT or 8- Bit Counter / Delay Macrocells

From Connection Matrix Qutput <30> |

N

From Connection Matrix Output <29>

Vv

From Connection Matrix Output <28>|

IN3

4-bit LUTO

IN1

ouT

16-bits NVM
reg <688:673>

From Connection
Matrix Output <27>

DLY_n/CNT_Reset

To Connection
Matrix Input <22>

H—

— CNT/DLY2 our
L > clk
1-bit NVM
reg <705>
Dialog Semiconductor www.dialog-semiconductor.com
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Properties 2]

4-bit LUTWCNT2/DLY2

5

o
=
_|
Ak

Type:

N2 IM2  IN1 IMOD

-
[a]

[ INL
GETED

R R R S L == =R =R =R == N =1
R I e e A R I T e e R S T T —
N == == s N e A== e A A==
H o R o RS R o RO RS RO o

[ury

Standard gates All to 0
Defined by user = ] All to 1
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Properties [
4-bit LUTOWCHT 2/DLY 2
Type: CMT,DLY =
Mode: [ Delay S ]I
Counter data: [ 1 I%]I
(Range: 1-255)
Delay time: 0.1400 ms Formula
Edge select: [B.;:.th - ]I
Connections

Clock: |FromrCOSC % |

Clock source: RC OSC Freq.

% Detailed R
Ej prlr
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ACMPO Block Diagram
to ACMP1, ACMP2,
ACMP3's MUX input reg <804> ——
ibias LBW
Selection Hysteresis
Extemnal VDD 1 Selection
27 =58Y reg <803:802> j‘
J% ”"
PING: ACMPO(H) 10 +_ll| Selectable | |+ To Connection
Gain Matrix Input<10>
External VDD 1.71V ~55 V | E— pdb s -
=
*PING_aio_en; reg <569>; reg <805>
*PING_aio_en- ON after
if reg <855:854>="11" then 1, otherwisf 100 ps Delay
PIN7- ACMPCY-
Bl ACIP (-

From Connection

Matrix Output <12>
Internal
Vref
reg
Properties
A CMPO
1uA pullup on -
input: Mone -
Hysteresis: Disable =

L1

Low bandwidth: || Disable

IN+ gain: Disable =
Connections
IN+ source: IPING = ]
IN- source: [ 50 myv =
Dialog Semiconductor www.dialog-semiconductor.com
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ACMP1 Block Diagram

reg <816>
| reg <812:811>
ibias LBW
Selection Hysteresis
External VDD 1 Selection
27V~55V reg <814:813>
T 11X
PIN10: ACMP1(+) : Selectable +\ To Connection
Gain Matrix Input <11>
From ACMPO’s MUX output " pdb Lis
ref

4

*PIN10_aio_en; reg <570>; reg <817>

*PIN10_aio_en: ON after
if reg <883:882>="11" then 1, otherwisé: 100 ps Delay
PIN12: ACMP1(-) 011

PIN12: ACMP1(-)

—— M Ii

From Connection

Matrix Output <13>
reg <810:806>

Internal
Vref

Properties
ACMP1
1uA pullup on -
input: Mone -
Hysteresis: Disable =
Low bandwidth: | Disable =
IN+ gain: Disable S
Connections
IN+ source: | PIN1O 3
IN- source: | 50 mY >
Dialog Semiconductor www.dialog-semiconductor.com
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ACMP2 Block Diagram

reg <827>

to ACMP3's MUX input

reg <824:823>

LBW
Selection

Hysteresis
Selection

reg <826:825>

PIN13: ACMP1(+)

To Connection
Matrix Input <12>

Selectable +

Gain L
L/s

From ACMPQ's MUX output

4

*PIN13_aio_en;reg<828>

*PIN13_aio_en: ON after
if reg <899:898>="11" & reg 100 ps Delay
<473:468>='000000’ then 1, otherwise:
PIN14: ACMP2(-)

PIN12: ACMP1(-)

V

reg <822:818>

From Connectiol
Matrix Output <14>

Internal
Vref

Properties
A CMP2
1uA pullup on
input: Mone
Hysteresis: Disable

Low bandwidth: | Disable

IN+ gain: Disable

Connections

IN+ source: [ PIN13

IN- source: IEI:Im'u'

Dialog Semiconductor www.dialog-semiconductor.com
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reg <558:557>

ACMP3 Block Diagram
| reg <661>
ibias LBW

Selection

reg <560:559>

PIN15: ACMP3(+) 100
From ACMPO’s MUX output 0 Selectable
Gain
From ACMP2's MUX output L

“

*PIN15_aio_en; reg<563>; reg<562>

*PIN15_aio_en:
if reg <913:912>="11"then 1, otherwise\d
PIN14: ACMR2(-)

PIN12: ACMP1(-)

Internal
Vref

/

reg <556:552>

Properties

ACMP3
1uA pullup on
ingut: Mone
Hysteresis: Disable
Low bandwidth: | Disable
IN+ gain: Dizable

Connections

N+ source: [ PIMN15
IN- source: IEU mY

From Connectiol

Matrix Output <23>

Hysteresis
Selection

|

To Connection
Matrix input <18>

L/s

ON after
100 ps Delay

Dialog Semiconductor
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Counters/Delay Generators (CNT/DLYO, 4, 5, 6)

reg <713>
™ Delay_IN
From Connection 0
Matrix Qutput <15>
Delay_IN/CNT_ext_clk CNT clock
1
Delay_out \6
Matrix Input <13>
reg <716:714>
1
RC O
SC 0
RC Osc/4 1
RC Ose/12 , CNT/DLYO
Counter_end
RC Osc/24 3
RC Osc/64 4 clk
ext. clock 5
[ - +
Count_end_out_x-1 7 .
Counter Control Data
reg <730:717>
Properties 3]
14-bit CNTO/DLYD
Mode: Delay =
Counter data: [ 1 |$] ° m S our
(Range: 1-16383)
Delay time: 01,1400 ms Formula
Edge select: [Bu::th S ]
Connections
N
Clock: | From RC OSC &
V
Clock source: RC OSC Freq.
Dialog Semiconductor www.dialog-semiconductor.com
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Counters/Delay Generators (CNT/DLY1)

reg <733>

~~L_ Delay_IN
Frem Connection 0
Matrix Output <16>

q 1 Reset_IN
/

Delay_out
reg <736:734> T

+J
RC Osc

RC Osc/4
CNT/DLY1

Counter_end

To Connection
Matrix Input <14>

RC Osc/12
RC Osc/24
RC Osc/64

> clk

ext. clock from EZIVI Out<17>

1

Count_end_out_x-1

i

~N o Ok~ WN =~ O

| |
Counter Control Data
reg <750:737>

Properties [

14-bit CNT1/DLY1

Mode: Delay -

Counter data: 1 l%

(Range: 1-16333)

Delay time: 0.1400 ms Formula
Edge select: [Both - ]
Connections
N
Clock: [ From RC 05C ¢y

Clock source: RC O5C Freq.

Dialog Semiconductor www.dialog-semiconductor.com
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Programmable Delay / Edge Detector

reg <966:965>
Delay Value Selection

N

To Connection
From Connection Matrix Output <7H/ Programmable Matrix Input <44>
—p N Del ay ouT L

reg <968:967>
Edge Mode Selection

reg <969>
Delayed Edge Detector Output

Properties (%)
P DOLY
Mode: [F‘.ising edge detectc ¥ ]
Delay: 1Cell =

Output mode: Mon-delayed =

Dialog Semiconductor www.dialog-semiconductor.com
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INV 0, INV 1 Gate

INV_0 Gate

From Connection Matrix Output <90> —>4|>c l = To Connection Matrix Input <59>>

Dialog Semiconductor www.dialog-semiconductor.com
12/19/2019 120



¢dialog

SEMICONDUCTOR GreenPAK Designer 6.21

Deglitch Filter

R Filter_0
From Cennection Matrix Output <21>
«l-’ To Connection Matrix Input <‘>

R Filter_1

From Connection Matrix Output <22> ——

——— 8 To Connection Matrix Input <61>

reg <962>

Properties

FILTER 0

Output mode: Maormal

Information
Delay
VDD Delay
18V 200 ns
33V T8 nz
55V 53ns
Dialog Semiconductor www.dialog-semiconductor.com
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VREF Block Diagram
External VDD
27V-55V
req <981> reg <799:795>
: CMPO_VREF
ext_vref_acmp0 - 88? r— — — 7 \
(Pin7) )
— req <810:806> 100 | | oP 4 Pin19_aio_en
— | e
! |
ext_vref_acmp2 reg <822:818> [ 0
(eintdly, |
CMP2_VREF 000 |
001
VDD /3 reg <556:552> ::8? ! oP | 1\ Pin18_aio_en
CMP3_VREF 110 | ] | || vietout_2(Pin18
VDD /4 - L
0
VDD /2
reg <998> VDD / 3
VDD /4 Vref Out_1 is floating in case of reg<994:992>=111 & reg<982>=0
Vref Out_2 is floating in case of reg<997:995>=111 & reg<983>=0
Properties
Force bandgap
on:
Output ackive
buffer:
Source
selector:
A CMPO
reference volt.
ACMP1
reference volt.
Dialog Semiconductor www.dialog-semiconductor.com
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Properties
VREF1
Force bandgap )
on: [ Dizable
E:#:::t TEOLS Dizable
Source
selector: [ TS
A CMP2 —
referencevolt. -
A CMP3 —
reference volt. 7"
Dialog Semiconductor www.dialog-semiconductor.com
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RC OSC Block Diagram
Internal RCO ~ Ireg <566:565> I
—
reg <708> 0
0: 25 kHz |
1:2 MHz L T
—— DIV /1/2/4/8 : : l P To Connection Matrix Input <45>
Pin 20 Ext. Clock 1 First Stage | |
Divider I 4 — P To Connection Matrix Input <46>
| |
Ext. Clk Sel reg <712> : :
[ I8 | 0 [
| |
I I
| |
| M2 1 ‘
: : —» To Connection Matrix Input <47>
I |24 L | 2 I
| |
I I
| |
| /64 L | 3 |
| |
| |
| I reg <711:710> |
| 13 | l P To Connection Matrix Input <48>|
I I
| ‘7 |
| |
| I3 = To Connection Matrix Input <49>
| |
L ___ 4
Second Stage
Divider
Properties
RC OS8C
RC OSC Power
- Auto Power On
register:

Clock selector: | RC OSC

RC 0SC
Freaency: | 25.00kHz
Clock

Crednider: | Clock/ 1

'CLK / X' out
divider select: I[ CLOCK /8

Dialog Semiconductor www.dialog-semiconductor.com
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A. Example projects.

In the GreenPAK Designer Help menu, you can find a link to the Application Notes web page for selected chip
revision. There you can find fully configured examples which can help get your projects completed more quickly.
Each example has documentation that contains diagrams and descriptions.
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B. Major features history.

6.02 Build 002:

®* Demo page (Section 2);

® Demo mode (Section 3.12);
6.05 Build 003:

® Simulation mode (Section 8);
6.09 Build 003:

® Debug tool (Section 6);
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